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Introduction: What is Chrono™ and What it Helps You Do 
Chrono™ is a software tool that augments Microsoft Project® to help users build and 
maintain more credible (and higher probability of success) project schedules.  To do so, the 
tool helps manage schedule risk in four ways: 

1. Supporting three-point estimates helps identify tasks with significant variance 
affecting the timeline that might be candidates for further risk review and 
mitigation 

2. Using statistical methods to produce the most accurate solution to a Monte Carlo 
simulation of a project plan, Chrono™ helps predict schedules more reliably and 
provides an approximate statistical confidence for milestone dates based on the 
estimates provided – an excellent visual aid for discussions of schedule and risk 
with executives 

3. By tracking schedule trends over time, Chrono™ uses Earned Schedule Management 
to provide feedback on how well a project is tracking against its predictions based 
on efficiency measurements, allowing early intervention when necessary 

4. Provides insight into how users can proactively change the project plan to achieve 
more acceptable schedule confidence dates 

The traditional scheduling practices that project managers have learned and used over the 
last 50 years are fundamentally flawed (for background see Why Traditional Schedules Fail) 
and produce overly optimistic predictions.  This presents itself as schedules that seem 
credible but are nearly impossible to achieve as planned.  A solution to this problem is 
schedule simulation using Monte Carlo methods, which produces more robust and credible 
predictions.   

Although tools have been available for years to support Monte Carlo simulations, 
historically they have been expensive, complex, cumbersome, hard to use, and slow 
(simulations can take minutes or hours depending on the size and complexity of the 
project being analyzed).  The “secret sauce” of Chrono™ is a mathematical acceleration of 
Monte Carlo – our patented TriCoBi™ algorithm – that increases accuracy and decreases 
simulation time to seconds, providing project managers with near-real-time results.  
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Chrono™ integrates this technology into a tool most project managers already use, 
Microsoft Project™, and provides a simplified interface that provides easy access to 
Chrono™ features.  Most of the computations are performed in the cloud and historical 
schedule information is securely retained there to facilitate trend analysis. 

Chrono™ leapfrogs the prior generation of schedule risk management tools that were 
unavailable to most organizations and teams because they were expensive and hard to 
use.  We built Chrono™ for ourselves, to help us manage our projects.  Our goal was to 
make the tool cost-effective, fast, and simple to use.  Our Chrono™ tool helps project 
managers better identify and address schedule risks and provide more sophisticated and 
useful schedule forecasts to sponsoring executives to support more informed decision 
making. 
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Tutorial #1 – Building and Validating an Integrated 
Master Schedule 

INTRODUCTION 
This first tutorial shows how to build and validate an Integrated Master Schedule (IMS) in 
Chrono™.  Schedules need to be “well-formed,” so that they can be properly simulated and 
result in actionable information that can properly guide a program or project. 

This section assumes that the user is familiar with standard scheduling principles as 
described in the Project Management Institute’s (PMI) PMBOK® Guide and has a basic 
working knowledge of Microsoft Project®.  

The basic scheduling knowledge required for this section include the following: 

• Task – the unit of work for resource allocation, estimation, scheduling, and tracking 

• Summary Task – a collection of tasks  

• Work Breakdown Structure (WBS) – the collection of all tasks and summary tasks 
for a project and the hierarchical relationships  

• Task-Level Assumptions – assertions made about uncertainties surrounding a task 
to facilitate planning and estimation, for example: “We assume the needed parts 
will be in stock/on-hand” 

• Network Diagram (sometimes referred to as the Gantt Chart) – a visual depiction 
of the project schedule that shows the order and dependencies of all tasks 

• Deliverable – the work products created by each task  

• Acceptance Criteria - the details of how a task will be measured to confirm that it 
is complete or meets the definition of done; this acceptance criteria must be agreed 
to in advance of estimating or performing work on the task  
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PLANNING STEPS 
The planning process can expand, or contract based on the size and complexity of a 
project but follows a basic process flow that can be shown in the series of planning steps 
listed below. This tutorial assumes that the user understands this process flow and will be 
able to follow it as needed to build out their schedule. 

1. Scope – Identify Tasks and their Interdependencies 
2. Create Preliminary Schedule 

A. Approximate Task Durations  
B. Determine Task Dependencies  
C. Enter Data to Build Preliminary Schedule  

3. Refine Estimates  
A. Develop 3-Point Estimates 
B. Update Tasks with 3-Point Estimates 

4. Optimize and Adjust for Risk 
A. Run TriCoBi™ Simulation 
B. Review Nominal and Goal Confidence Levels 
C. Change the Commitment Milestone to Achieve the Goal Confidence and 

Rerun the Simulation 
D. Optimize Plans 

5. Review Plans with Sponsor  
6. Update Project Plan per Sponsor’s Review  
7. Final Project Plan Review with Sponsor and Team  

Scope – Identify Tasks 
A common method used to identify tasks and create the Work Breakdown Structure (WBS) 
is to have a brainstorming session with the core project team and Subject Matter Experts 
(SMEs). In this session, they would discuss the work products representing the value to be 
created for the end goal of the project and describe the tasks necessary to create those 
work products. 

These tasks are then placed in a hierarchy called a Work Breakdown Structure which 
consists of the “tasks” (work items) and “summaries” which represent collections of tasks 
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and summaries.  Summaries are used to organize tasks, much like folders might be used to 
organize files on a hard disk. 
 

 
Figure 1 Work Breakdown Structure Framework 

Create Preliminary Schedule 
Creating the preliminary schedule consists of three steps: 

1. Approximate Task Durations 
2. Determine Task Dependencies 
3. Enter data into Microsoft Project® 

Each of these are discussed in the sections below.  We assume you are using Microsoft 
Project® to create the preliminary schedule. 

Approximate Task Durations 
The first step in building a schedule is to create initial duration estimates for identified 
tasks.  These initial durations or rough estimates are a first guess at the time needed to 
complete each task and should be an honest best guess – not optimistic or pessimistic. 
These durations will be used for the preliminary schedule development and later they will 
be replaced with a 3-Point risk adjusted estimate used to determine the overall project 
schedule. The team should develop approximate task durations in a manner comfortable 
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for the team. Some common methods used by teams include expert opinion, analogy, and 
planning poker.  The team should record any assumptions made when approximating 
durations.  These can be revisited later in the planning process as part of refining estimates, 
assigning resources, and managing risk. 

Determine Task Dependencies  
The goal of this step is to determine the logical sequence of the identified tasks.  Sequence 
is often represented as a network diagram that describes the task dependencies.  The 
network diagram consists of 3 basic elements: 

1. Milestones – Milestones represent significant moments in time for the project.  At a 
minimum, all projects should include a Start and Finish milestone.  The Start 
milestone represents the beginning of project work.  The finish milestone represents 
the completion of all project work. 

2. Tasks – Tasks are the elementary unity of work for scheduling, assignment, and 
tracking. 

3. Dependencies – The arrows that show the relationship among the tasks, usually 
described as “Finish to Start”, meaning “Task A must be finished before Task X can 
Start”. 
 

 
Figure 2 Example Network Diagram 

Determining the logical relationships among tasks can be challenging and is best 
approached as a team effort.  Conceptually what happens is an assumption is made about 
the start date of the project and the start milestone is created.  Next, tasks that could 
begin as soon as the project starts without input from other tasks are listed as successors 
to the start milestone.  Then, other tasks are added showing their dependencies upon prior 
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tasks until all tasks are accounted for. Finally, a finish milestone is created as a successor to 
any task that doesn’t already have a successor.   

When the network diagram is complete, the following should be true: 

1. There is a start milestone scheduled to occur at a fixed date in the future when we 
assume the project work will begin. 

2. All tasks have at least one successor (task or milestone that is dependent on that 
task finishing before it can start). 

3. All tasks have at least one predecessor (task or milestone that must be completed 
before this task may begin). 

4. There is a finish milestone tied to the completion of the last tasks in the project.  
When the finish milestone occurs, all project work should be complete. 

While discussing and capturing task dependencies it is common to discover tasks that 
were initially missed and must be created, are redundant and can be eliminated or 
redefined to avoid redundancy, and tasks that might be either decomposed further for 
better granularity or consolidated with other tasks for simplicity. 

At this point in schedule development, don’t worry about the resources necessary to do 
the work.  The preliminary schedule is about capturing the logical sequence of the tasks.  
Resource considerations are addressed later. 

Enter Data to Build Preliminary Schedule 
After creating the network diagram as described above, we are ready to use the 
scheduling tool.  For our tutorial, the preliminary schedule is created by entering the tasks, 
durations, and dependencies into scheduling tool like Microsoft Project®. 

For the purposes of this tutorial, the project schedule data table in Figure 3 will be used for 
constructing the original project IMS (Integrated master Schedule) or Gantt chart shown in 
Figure 4 by following the subsequent step by step instructions.   

 

 



  Improved Decision Making  

©2023 RTConfidence, Inc. V2.4  Page 11 

Task ID Task Name Duration Predecessors 
1 Start Milestone  0  
2 Prototype Development     
3    Prototype Design 45 1 
4    Buy Prototype Parts 59 3 
5    Prototype Build 30 4 
6    Test & Evaluation 20 5 
7 Final Product Development     
8    Final Product Design 35 6 
9    Final Design Review 0 8 
10    Buy Parts for Qual Units and Production 40 9 
11    Assembly of POR (Plan of Record) Units 15 10 
12    Conduct Qual Tests 20 11 
13    Verify Final Design Iterations 20 12 
14 Conduct Launch Readiness Review 0 13 
15 Buy Production Parts 30 12SS+10 days 
16 Start Production   14,15 
17 Commitment Milestone   16 

Figure 3 Source Data for Original Schedule 

Steps to create initial Microsoft Project Gantt Chart for the tutorial: 

1) Open Microsoft Project® and create a Blank Project. 

2) Confirm that Chrono™ is installed and functioning by assuring that the Chrono™ tab 
is visible near the File tab across the top of the application. 

3) Observe that Chrono™ adds some initial milestones and a first task place holder to 
your blank schedule when it is created. 

4) If needed, go to the File > Options > General > Project view setting and change the 
Date format to include hours. Example: 3/18/22 12:33PM.  

5) Update the Start Milestone to begin 2/3/20 8:00 AM (if you use this exact date and 
time for the tutorial then your output should match the examples below), and 
update the corresponding project start date in the Project Information dialog from 
the Project tab. 
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6) Insert 13 tasks below TaskID #2 (TaskID #2 task name is “Put your first task here”). 

7) Select and indent TaskID #3-#6 to promote TaskID #2 to a summary task. 

8) Select and indent TaskID #8-#13 to promote TaskID #7 to a summary task.  

9) Copy the task names from tasks #2 through #15 from the table above into the 
corresponding task name fields in the Microsoft Project® table. 

10) Copy the durations from TaskID #3-#6 and #8-#15 into the Durations column of the 
MS Project table. 

11) Clear the predecessor in TaskID #2. Copy the predecessors from tasks #3-#6 and 
#8-#16 into the Predecessors column of the MS Project table. 

12) Rename task #16 to “Start Production”.  Confirm that it has a duration of zero. 

13) Save your work and name the file “Tutorial Project #1.mpp”. 

14) Click the “View Entire Project” button on the Chrono™ Tools ribbon. 

 

 
Figure 4 Button for Viewing Entire Project Width 

15) Click the “Align Commit” button on the Chrono™ Tools ribbon and choose “Yes” for 
End of Day. 

 
Figure 5 Button to Align Commit to Goal 

 

 
Figure 6 Pop-up to Align Commit to End of Workday 
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16) View the Gantt chart. It should look like the following figure and have 3/4/21 5:00 
PM as the Commitment Milestone. 

 
Figure 7 Preliminary Schedule 

The project schedule needs to be “well-formed” for it to be simulated. The Chrono™ 
“Validate Project” wizard is used to perform the project validation, assuring that all tasks 
have a predecessor and successor, start as soon as the task logic allows, and that 
summaries do not have predecessors or successors or fixed dates. Click the “Validate 
Project” button on the Chrono™ Tools ribbon to run the validation: 

 
Figure 8 Button to Initiate the Schedule Validation Check 

 

The project should validate properly and present a “Validate Project – Passed” message to 
the user. 

The details of what validation does are discussed here. 

As an example, clear the predecessor from task #6 and it will cause a validation failure. This 
will result in task #5 having no successor.  Run the “Validate Project” wizard again. See the 
wizard message showing the integrity error in the project structure: 
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Figure 9 Validate Project Error Dialog 

Since predecessors and successors are directly related, fix the issue by inserting “6” as a 
successor to task #5 in the dialog and pushing “Next”. This will make task #6 the successor 
of task #5 restoring the schedule integrity.  The wizard should now complete validation 
successfully and display the “Project Validation – Passed” message. 
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Refine Estimates 
Next, we will review and refine the estimates, working with the team to develop 3-point 
estimates that give us insights into the likely variability of task durations.  We assume that 
the team who created the original plan has been requested to do and SRA analysis to 
determine the % Confidence of that 3/4/2021 commitment date.  The first step is to 
develop 3-point estimates for each risky task. 

Develop 3-Point Estimates 
Chrono™ helps create realistic schedules by utilizing the information normally hidden in the 
natural variance of task estimates.  To support this analysis, three estimates are created for 
tasks with a known risk of duration variability.  These estimates and their definitions are: 

• Best-Case Estimate – the shortest reasonable duration that resources and 
technology would allow the task to be finished.  This is how quickly we could get 
this done if things went very right. 

• Nominal-Case Estimate – the most likely duration of the task according to history or 
expert opinion.  The nominal estimate assumes that things go reasonably well, but 
not perfectly – and there are no significant surprises.  Microsoft Project® labels this 
simply, “Duration”. 

• Worst-Case Estimate – the longest reasonable duration of the task absent 
extraordinary problems.  Typically, this would be characterized by the estimator as 
the longest the task would reasonably take barring natural disaster or other 
disruption. 

Ideally, we obtain the best-case and worst-case estimates by engaging the same people 
who developed the original “task duration estimates. For each task, discuss what would 
have to go right for the duration to be shortened assuming the resources and project 
priorities remained the same, and what that optimistic but credible best-case duration 
would be.  Then discuss what kinds of things could go wrong with the tasks that would 
delay completion and ask what the pessimistic or worst-case duration would be.  In both 
cases, limit the discussion to things that are controlled by the team or normal things that 
impact the team and have some reasonable likelihood of happening during the project. 
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Examples: 
A. When discussing the best-case duration, a subject matter expert (SME) might 

say, “If we had all of the needed parts in stock at the beginning of the task and 
we could focus on it full time, we might be able to build the prototype in as 
little as 8 days rather than 10.” 

B. When discussing the worst-case duration, the SME might say, “Expanding the 
server room could be delayed if there were insufficient power on the designated 
electrical circuits or if cooling the new equipment exceeded the capacity of the 
existing HVAC unit.”  Either of these situations would extend the nominal 30 day 
estimate to as much as 45 days. 

C. When discussing the worst-case duration, a SME might say, “If there is another 
pandemic this estimate goes out the window.”   To which a project manager 
could reply, “Let’s focus on the normal things that go wrong with tasks like this.  
Pandemic delays are beyond the scope of our estimation exercise, and we can 
deal with them as part of our overall risk management strategy.” 

When teams revisit task durations to develop best-case and worst-case estimates, they 
sometimes find they can also justify changing the nominal or expected case duration. 
Often a team will feel more comfortable shortening the nominal durations when given the 
opportunity to capture the worst-case durations, effectively removing internalized or 
hidden task duration risk buffers. The result is a much more credible 3-point estimate for 
each task. 

For additional discussion of 3-point estimates, see 3-Point Estimates. 

 
Update Tasks with 3-Point Estimates 
The next step in our tutorial is to run the “Chrono™ Wizard” to add the best-case and 
worst-case duration estimates to each task.  Use the following project data table for the 
best-case and worse-case task durations in the tutorial update.  This should assure that 
your output matches the illustrations below. 
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Task ID Task Name Best-case 
Duration 

Nominal 
Duration 

Worst-case 
Duration 

3    Prototype Design 40 45 60 
4    Buy Prototype Parts 59 59 64 
6    Prototype Build 25 30 40 
8    Test & Evaluation 15 20 30 
     

10    Final Product Design 30 35 50 
     

12    Buy Parts for Qual Units and Production 40 40 40 
14    Assembly of POR (Plan of Record) Qual Units 8 15 20 
16    Conduct Qual Tests 15 20 50 
17    Verify Final Design Iterations 20 20 40 
     

19 Buy Production Parts 30 30 40 
Figure 10 Project Data Table for Inputs 

Steps to add updates to project tasks with 3-point estimates: 

1) Launch the “Chrono™ Wizard” by clicking on the Chrono™ Wizard button in the 
Chrono™ Tools ribbon. 

 
Figure 11 Button for Initiating the Chrono™ Wizard 

 
2) Note the TaskID in top right corner of the wizard.  For the tutorial, TaskID #3 should 

be shown.  You can navigate to a different task by entering the task number in the 
TaskID box or using the slider next to the data entry box, or by selecting Next. 



  Improved Decision Making  

©2023 RTConfidence, Inc. V2.4  Page 18 

 
Figure 12 Wizard Data Entry Pop-up with Single Nominal Duration Entered 

3) Update the best-case value and worst-case value from the data table. Optionally, 
you can add a text description reason for the possible the best-case scenario in the 
Opportunity field using a drop-down item or as a text input.  Optionally add the 
reason for the possible worst-case scenario in the Risk field.  

 
Figure 13 Wizard Data Entry Pop-up with 3-point Duration Estimates Entered 

4) Click the “Next” button to commit the changes and move to the next TaskID.  
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5) Repeat the process for all tasks that have 3-point estimates. For the purposes of the 
tutorial, enter the rest of the best-case and worst-case durations from the table 
above. 

6) After updating the durations, the Chrono™ Wizard will present the opportunity to 
update the predecessors and successors again. No changes are needed for the 
tutorial. 

7) Close the wizard by completing the update sequence or by clicking on the “Exit 
Wizard Save Changes” button or the “Done with Durations” button. 

Preparation for Running the Simulation 
To run the TriCoBi™ simulation and see the output results, we need two conditions to be 
met: (A) the IMS must pass Chrono’s “validation” test, and (B) valid Chrono™ and 
ChronoView™ usernames (e-mail addresses) must be entered into the Default tab’s Login 
screen.  Instructions regarding each are provided below.  

Using the “Validate Project” Wizard Criteria 
With Chrono™ your IMS is required to conform to certain schedule-structure criteria to use 
the SRA (Schedule Risk Analysis) and ES (Earned Schedule) features.  These criteria are 
closely aligned to the DCMA (Defense Contract Management Agency) 14-Point Metrics 
(refer to detailed description here). Suffice it to say, Microsoft Project enables users to 
create any kind of project schedule they wish to create (and it should), but that does not 
mean that they are acceptable for use in the advanced applications mentioned above.  
Thus, the developers of Chrono™ elected to provide “wizards” to help users prepare their 
IMSs for SRA and ES integration. Select “Validate Project” (shown below) and a wizard is 
activated. If not valid, schedule structure issues will be systematically identified, with 
helpful hints for fixing issues. Once the IMS passes validation, it is deemed simulation 
ready.   

 
Figure 14 Button to Initiate the Schedule Validation Check 
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Logging in to Secure Chrono™ Simulation Portal 
The Chrono™ team has worked hard to ensure user data is protected and secure.  One of 
the safeguards is the Chrono™ Login provision.  Your Username (e-mail used to secure the 
license) will be automatically populated in the Chrono™ Defaults Settings.  As shown in the 
below graphic, users are also able to populate two “Chronoview™” user e-mails of people 
approved to view the Chrono™ simulation outputs.  See here for more information. 

 
Figure 15 Chrono™ Login Screen within Default Settings 
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Optimize and Adjust for Risk 
The next step in planning the project is to run the TriCoBi™ Simulation. This simulation 
provides a Monte Carlo simulation result, but orders of magnitude faster - allowing for 
“What-If” analysis in seconds rather than minutes or hours.  The results of the simulation 
will provide insights into opportunities to address schedule risk.   

Run TriCoBi™ Simulation 
Like a Monte Carlo simulation, the TriCoBi™ simulation combines the probabilistic 
distributions for each 3-point estimate into a combined probabilistic distribution for the 
whole project schedule. The probability of each possible completion date for the project is 
summed up, accumulated, and presented on an “S-curve” where the confidence-level of 
every possible end-date is presented.  

The steps to run the TriCoBi™ Simulation: 
1) In the Chrono™ Settings portion of the Chrono™ ribbon, select “Defaults”.  This will 

display the Default Settings dialog and allow you to select the triangle probability 
type.  For purposes of our tutorial, select the distribution type of “TriGen™" then 
“Save” the changes. 

 
Figure 16 Default Section for Changing Probability Type 

(Note: See the appendix here for an explanation of the different triangles and 
how this setting impacts the simulated timeline.) 

2) Click the “Run TriCoBi™ Simulation” button in the Chrono™ Tools ribbon. The warning 
triangle on the left of the button is present whenever the simulation needs to be 
run because of changes in the project data since the last simulation was run.  

 
Figure 17 Button for Running Simulation 

3) Project validation will automatically run and, if successful, then the simulation will 
proceed. When the simulation is finished, choose to display the probability chart by 
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selecting “Yes” on the dialog presented.  Note that if this is the first time you’ve run 
the simulation, you will have to enter your login name (i.e., e-mail address that the 
Chrono™ license is registered under) and password.  Subsequent simulations will 
post without logging in again for the near future (i.e., within 24 hours of dormancy 
in running the TriCoBi simulation and viewing the outputs).  After a successful log-in 
(i.e., the system verifies your viewing rights), the following graphic is displayed:  

 

Figure 18 ChronoView™ Browser Landing Page Output Graphic 

Review Nominal and Goal Confidence Levels 
The project’s Commitment Milestone (TaskID #17) probability distribution and confidence-
level S-curve values are presented – this is the default web browser output. Notice that 
the Nominal confidence-level is 0% (if you hover your cursor over the S-Curve at that date 
you will see that t is actually 0.27%). This shows that the “expected” durations of the tasks 
provided by the subject matter experts have a 99.73% chance of failing to hit the non-
simulated original timeline calculated by Microsoft Project® in the Preliminary Schedule 
previously shown in Figure 7.  
 

Generally, we recommend that teams present their estimated timeline to the business 
using the TriGen™ distribution type and confidence-level of 50% or higher (i.e., the 
established GREEN zone lower limit). Some managers prefer to present a 70% or 75% 
confidence-level to the business for organizational commitments. 
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The output above shows that the original timeline calculated by Microsoft Project® using 
traditional critical path method (CPM) and the nominal estimates resulted in an end date of 
March 4, 2021. When the simulation factors in the expected duration variance reflected by 
3-point estimates, it generates a more realistic end date of May 11, 2021, as depicted below. 
In summary, this example shows how an 11-month schedule created in good faith can be 
off by over 2 months (nearly 20%) due the difficulty of combining tasks that have an 
expected natural variance.  

 
Figure 19 Chrono Distribution Output Information Box 

Implementing Proactive Risk Management for a More Acceptable % Confidence 

If we go back to the Chrono™ tab in our Microsoft Project IMS and select “Goal Confidence 
@ 70%” within the Chrono™ Gantt Charts Views section, we get the following result: 

 
Figure 20 Goal Confidence @ 70% Cantt Chart View 

If your team has already committed to the 3/4/2021 completion deadline, your project 
sponsor (especially if under contract to perform this project) is not likely to just let you 
move that completion date out.  So what do you do?  Answer: engage in proactive project 
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risk management and figure out how to improve the confidence level for meeting the 
3/4/2021 completion deadline.  Go here to see how proactive risk management was used 
for this notional project plan, and what the Chrono™ tool offers to aid in this important 
activity.  For now, let’s assume that you completed that proactive risk management effort 
and generated the following revised Gantt chart: 

 
Figure 21 Revised Nominal Durations (Critical Path) Gantt Chart 

Notice that to achieve a 70% or higher commitment confidence, our Nominal Durations 
(Critical Path) Gantt chart shows that the team completes the project by 1/1/2021 (over 2 
months earlier than the 3/4/2021 commitment date).  Let’s run the simulation to see what 
our SRA dates and % confidences are now.  Below is the simulation’s Distribution output: 

 
Figure 22 Revised Project SRA Distribution Chart 
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We see from the prior figure that although our “Commitment” confidence is still the same 
as the Nominal (or Critical Path) level, which is less than 1%, the Goal Confidence of 70% is 
achievable for a 3/4/2021 commitment date.  The next section will walk us through the 
process of aligning the Goal and Commitment completion dates. 

For more information about Monte Carlo simulation compared to traditional critical path 
method schedules, see appendix here. 

Change the Commitment Milestone and Rerun the Simulation 
The next step in our tutorial is to change the Commitment Milestone and rerun the 
simulation.  

Steps to update the Commitment Milestone: 
1) Navigate to the Microsoft Project® schedule. 
2) Select “Goal Confidence @ 70%” button on the Chrono™ Gantt Chart Views ribbon. 

 
Figure 23 Button for Viewing Goal Confidence Gantt 

3) Note the green check mark on Goal Confidence indicating that this is the Gantt 
chart currently being displayed. 

 
Figure 24 Button with Green check mark 

4) Observe that the Gantt chart tasks have been moved to reflect the 70% 
confidence-level timeline. 

5) Click the “Align Commit” button on the Chrono™ Gantt Chart Views ribbon.  This 
fixes the start of the Commitment Milestone to align with the completion of its 
predecessor, in our tutorial this is the Start Production milestone which is scheduled 
to occur on 3/4/2021 at the 70% confidence level. 

 
Figure 25 Button to Align Commit to Gantt End Milestone 
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6) Select “Yes” on the “Align to end of day?” question. 

7) Note that the “Run TriCoBi™ Simulation” button in the Chrono™ Tools ribbon has the 
yellow warning triangle signifying that the TriCoBi™ Simulation needs to be run 
again. 

 
Figure 26 Simulation Button with Yellow Warning Sign 

8) Re-run the TriCoBi™ Simulation. 

9) Notice that the warning triangle on the “Run TriCoBi™ Simulation” button is gone 
signifying the project dates for the various Gantt views for each confidence level 
are up to date.  

 
Figure 27 Simulation Button without Warning 

10) Select “Yes” to display the probability charts on the dialog presented.  

11) See the Commit Confidence date is now on March 4, 2021 with a 72% probability. 
(The difference between the 70% Goal Confidence and the 72% Commit Confidence 
is the “Align to end of day” setting above.)  

 
Figure 28 Output Distribution Box with new Dates 

12) Review the project distribution curve for the Commitment Milestone. Hovering the 
curser over the Commit Confidence diamond shows the confidence-level to be 
71.69% for an end of day March 4, 2021 project end date. 
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Figure 29 Probability Distribution Chart 

 
13) Navigate back the Microsoft Project® schedule. 

14) Select “Goal Confidence @ 70%” button on the Chrono™ Gantt Chart Views ribbon. 

 
Figure 30 Goal Confidence Gantt Chart Button 

15) Click the “View Entire Project” button to have the Gantt chart scaled to fit into the 
space available on your computer display. 

 
Figure 31 The View Entire Project Button 

16) See the full schedule in the Project Gantt showing the 70% confidence-level dates 
for each task as well as the overall timeline. 
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Figure 32 Full Gantt Chart - Revised 

17) Select from the Project menu “File > Save” to protect the work to this point. 

18) Select from the Project menu “File > Save As” to create a backup copy of the work. 
(Use the file name “Tutorial Project #2.mpp”.1) 

19) Perform the next steps in the tutorial with the “Tutorial Project #2.mpp” file. 

Optimize Plans 
Project plan optimization involves trying to adjust the scope, schedule, and resources of 
the project in the context of known risks to achieve the project objectives and provide 
options to the sponsor if that can’t be accomplished credibly.  Chrono™ assists with 
schedule optimization and schedule risk management by helping project managers create 
realistic schedules through probabilistic simulations that identify opportunities and risks 
that can the addressed directly by the organization. The tools for this include identification 
of the merge bias interactions that impact the schedule and the tornado chart that the 
shows the tasks that have the largest potential positive or negative impact variance on the 
project schedule. Often, an organization may seek to compress a timeline by adjusting the 

 
1 Important point: Never use the operating system copy command to make a copy of a Microsoft Project® file that has 
been used with Chrono™, instead use “Save As…” in the application menu.  Microsoft creates a unique identifier for each 
project file when you create a new project or do a “Save As…” that is hidden inside the file.  Chrono™ uses that to identify 
your project and save historical information in the cloud.  If you make a copy of a file using the operating system, then 
both files will have the same (no longer unique) identifier, and this will confuse and potentially corrupt the historical data 
retained about your project that is used to track trends. 
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resources applied to the program.  This might include adjusting team sizes and skill sets or 
expediting capital purchases that could have a positive impact on the schedule.  

Note that the Chrono™ developers recognize that viewing Microsoft Project Gantt charts 
requires a Microsoft Project license, so for those who don’t have one, the team decided to 
replicate the 5 Chrono Gantt charts, to the degree possible/practical) for enabling others 
to view the vital aspect of the corresponding Gantt charts in this “ChronoView™” offering.  
An example is shown below. 

 
Figure 33 Gantt Chart View Example 

Observe the impact of Merge Bias by selecting the “Merge Bias” tab on the web-based 
Chrono™ Chart.  This shows that the merge bias contributes to likely schedule delays on 
three tasks. See Appendix here for ideas about how to optimize a schedule for merge bias. 
For this tutorial we will accept the current merge bias. 
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Figure 34 Merge Bias Chart 

 

1) Look for opportunities to optimize the schedule and mitigate schedule risks by 
reviewing the Tornado tab on the web-based Chrono™ Chart. The chart identifies 
tasks that are contributing the most to extending the schedule.  In our tutorial 
example, the Tornado chart shows a significant opportunity to pull in the schedule 
by reducing the variance on the “Conduct Qual Tests” shown in TaskID #16 on the 
chart below. The chart also shows six additional risks that, if mitigated, could help 
reduce the overall schedule duration further.  

2) When working to shorten a schedule we recommend reviewing the tornado chart 
items one by one and acting to reduce their variance in addition to reviewing 
overall task logic to confirm dependencies and reviewing the critical path for 
opportunities to better allocate resources for schedule optimization. 
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Figure 35 Tornado Chart 

Review Plans with Sponsor  
Once plans have been optimized as much as possible within the bounds authorized by the 
project charter, budget, schedule, and resource plans are normally presented to the project 
sponsor for review and discussion, along with identified risks and remedies and any 
recommendations for changes in the original project charter/definition constraints or goals. 

Chrono™ components that may aid that review include: 
• Probabilistic distribution chart – Helps visualize the uncertainty of the scheduled 

end date 
• Tornado chart – Identify tasks with significant positive or negative variance that 

might be targets for further optimization 
• Merge bias chart (if it has significant impact on the timeline) – Helps explain hot 

spots of schedule variance 

The initial sponsor review typically results in discussions of potential remedies for out of 
bound conditions in the current plans and possibly agreements to change the project 
constraints, assumptions, or definition.  If the project plans are deemed acceptable, this 
review presents an opportunity for a Go/No-go conversation.   
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Update Project Plan per Sponsor’s Review  
If the sponsor requests additional optimization this might include adding, deleting, or 
changing tasks, adjusting budgets, changing schedule targets, modifying personnel 
assignments, or adjusting assumptions underlying aspects of the plan.  Chrono™ can 
continue to play an ongoing role in modeling schedules and schedule risk.  Users can adjust 
3-point estimates as needed, run schedule simulations, and review the results with the 
team as part of schedule refinement. 

Final Project Plan Review with Sponsor and Team  
When the last bout of optimization has been performed and before the schedule is 
approved and the initial baseline established, we recommend a final review of the 
schedule with the project sponsor and team to establish buy-in.  

Make clear to the team that they will be striving to deliver according to the nominal-case 
estimates schedule they provided for their tasks.  The team should understand that some 
variance is expected, and that the organization has taken that into account.  Both the team 
and sponsor should understand that organizational commitments for project deliverables 
will be based on the timing from the commitment confidence which will usually be set to 
70% or higher.   
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Tutorial #2 – How and Why to Set Baselines 
Once the team and the sponsor have agreed to a project schedule and there is a decision 
to begin the project on an agreed upon date, it is time to set the project baseline. The 
project baseline is a snapshot of the approved schedule that will be used as a benchmark 
to gauge schedule performance as the project progresses.  

WHAT IS A “BASELINE”?  
Think of the baseline as a line drawn at the base of each task in the Gantt chart in 
permanent ink.  Task durations and start dates may fluctuate and cause the task to move as 
status is entered or estimates are changed, but once the baseline is established and saved 
it persists (until explicitly updated) and indicates when the task was scheduled to occur 
when the baseline was set.  Comparing the baseline to the position of the task bar helps to 
visually identify variance between when the tasks occurred or are currently scheduled to 
occur and when they were planned to occur when the baseline was set. 

The baseline function in Chrono™ is customized and replaces the standard Microsoft 
Project® baseline function. Do not set a baseline when using Chrono except through 

the procedure below. 

 
SETTING A BASELINE 
These are the steps to set the Chrono™ specific baseline: 

1) Confirm/adjust the date of the Start milestone.  No change is required for this 
tutorial. 

2) Select “Set Project Baselines” button on the Chrono™ Tools ribbon. 
 

 
Figure 36 Button for Setting the Project Baselines 

3) Select “Yes” to the sponsor approval question.  
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Figure 37 Chrono Warning to Verify User is Ready to Set Baselines 

4) The screen will flash as an additional backup file is stored for the baselines. 

5) Baselines are set for both the Nominal Durations and the Goal Confidence 
Durations. 

6) The TriCoBi™ Simulation is rerun. 

7) Choose to see the web graphics. 

8) See that the baseline is set in the top right side of the header.  The modified date 
should reflect the current date and time. 

 
Figure 38 Baseline Information in Output Header 

WHAT CHRONO™ RISK CONFIDENCE INFORMATION MEANS 
1) See the Distribution Trend chart which should be showing: 

a. Initial project status date is February 3, 2020 (the date of the project start 
milestone). 

b. The baseline confidence level is 72%. This means that if the current 3-point 
estimates and task dependencies are generally correct, Chrono™ analysis 
predicts that there is a 72% chance of completing the Commitment 
Milestone on or before the Goal Confidence schedule target. 
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c. End-date variance (the interval between the 10% likely date and the 90% 
likely date) is 44 days. This means that project has an 80% chance of 
completing within the middle 44-day period. We usually use this confidence 
interval quantity of days to understand how well the risks are reducing over 
time. Each time the project is updated, the number of days within the 10% to 
90% confidence interval should be reduced. The reductions start small in the 
beginning and get larger as the project nears completion, signifying that 
more of the project tasks are complete and the opportunities for variance 
are decreasing.  

d. Goal confidence band is set to 70%. This means that the project has a 70% 
chance of completing on or before the date that corresponds to the 70% 
confidence-level. We have found that a 70% or higher confidence level is 
both attainable and sufficiently aggressive to minimize program costs. There 
are always exceptions to this rule, so the project manager will need to 
determine what goal confidence level is the best fit for their organization 
and adjust that factor in the Defaults dialog. 

e. Medium risk confidence band is set to 50%. This factor is typically used for 
two different purposes. The first use is to schedule internal hand-offs within 
the organization such as the hand-off between a hardware team and a 
firmware team working on the same product, where it is important to be 
both aggressive on the schedule and still establish a fairly reliable hand-off 
date. The second use is as a warning flag for the entire project. If the 
confidence level of the commitment date reaches 50%, then the project is 
entering a level of uncertainty in its delivery timing that should be fully 
understood. Reaching this confidence level from a starting level of 70% 
suggests that something major has changed from the project planning 
assumptions such as the productivity of the team, or more risks are 
materializing than expected. If after exploring the confidence level variance 
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action is needed, then it should be taken promptly as changes in a program 
typically grow more expensive over time.  

f. High risk confidence level band 30%. This factor is also typically used for two 
different purposes. The first use is as an alternative to the nominal or critical 
path confidence level for planning aggressive task executions within a single 
team with no external hand-offs. The second use is as a critical warning flag 
for the entire project. If the confidence level of the commitment date falls to 
30%, then it is unlikely that a normal recovery plan can recover the project 
slippage and more proactive steps by the organization will be needed to 
realign the project to its business objectives. 

 
Figure 39 Distribution Trend Chart with Baseline SRA (Schedule Risk Analysis) Data 

2) The Earned Schedule Management (ESM) tab provides baseline, Earned Schedule, 
projected, and actual burnup charts for both the goal confidence level and the 
nominal confidence level. Monitor both the slope of these lines and the extension 
of the lines to understand a possible change in the project end date and monitor 
the health of a projects. In the tutorial example, these charts show the project ready 
for its first schedule update with actuals (no actuals are shown yet). 
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Figure 40 Goal Baseline Earned Schedule Chart 
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Tutorial #3 – Tracking Projects with Earned Schedule 
Management 
Starting with a realistic schedule is a great way to launch what we hope will be a 
successful project. Once project work begins, the next challenge is monitoring status to 
determine whether the project remains on track to meet its schedule objectives.  

Because gathering status data and pro-actively mapping schedule trends is difficult and 
time consuming without the right tools, many projects simply track and report on historical 
performance. This is rather like driving your car with your windshield blacked out, watching 
your rear-view mirror to see what is behind you. 

Chrono™ tracks completion of historical tasks and monitors consumption of the risk buffers 
(the difference between the Nominal Schedule and the baselined Goal Confidence 
Schedule) to calculate the likelihood of achieving schedule commitments after each status 
update.  This is done using a process called Earned Schedule Management (ESM). 

DISCIPLINED EXECUTION FOR PROJECTS 
If an organization cares about project schedule performance, then tracking a project based 
on what has been completed at various milestone stages is necessary but insufficient. A 
tracking metric that focuses exclusively on what has been completed in the past is called a 
“lagging indicator.” While lagging indicators reflect history, they do not provide insights 
into future consequences or guidance on what needs to happen to improve performance. 
A smoke alarm is an example of a lagging indicator.  It does not prevent fires; it merely 
identifies when the smoke from a fire is detected. 

Leading indicators are predictive, designed to track progress of historical events (lagging 
indicators) and forecast the consequences of that performance on future tasks. An 
example of a leading indicator: my car monitors fuel consumption, fuel tank capacity, and 
distance traveled to provide me with a constant prediction of how many miles I can go 
with the fuel remaining in my tank at the current rate of consumption. 

In this way, leading indicators and lagging indicators go hand in hand. The lagging 
indicators track the completion of historical tasks and milestones and the leading 
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indicators calculate trends from lagging indicator performance to predict whether the 
project is on pace to hit future milestones at their forecasted time.  

As work progresses and actual task performance is recorded (hopefully in the range 
defined by 3-point estimates), a consistent analytical method must be used to measure 
progress and predict the impact of variance.  The metric used to track progress is not the 
time already invested in a task, but instead, the time remaining to complete the task. 
Periodic status collection will gather from team members the currently estimated time 
required to complete all unfinished tasks. 

EARNED SCHEDULE MANAGEMENT AND RECOVERING FROM 
PROJECT SLIPPAGE  
The statistical schedule management approach Chrono™ uses to combine the “time 
remaining status” information for incomplete tasks is called Earned Schedule Management. 
It is similar to more traditional Earned Value Management (EVM) but uses task durations 
instead of monetary measures. The ESM process provides a view into the project’s progress 
in terms of its current velocity or pace. 

As a project manager, it is important to know if project velocity is steady, slowing, or 
accelerating. Lagging indicators alone do not provide insights to understanding the 
project’s velocity, but ESM leading indicators do. 

Historically, the best project managers gauged the velocity of a project based on clues 
obtained by informally monitoring the project’s leading indicators. These project managers 
knew when to take action because of their intuitive sense of the project's velocity. The 
ESM feature of Chrono™ takes the remaining duration for each task and calculates the 
project’s current velocity. The project manager can then use this information to confirm the 
project is on track to meet its timeline or determine that one or more impediments are 
impacting project performance. The project manager can then act early to avoid a major 
schedule slip before recovery is impossible.  

TRACKING PROJECTS IN CHRONO™  
Tracking a project using ESM in Chrono™ requires that an initial baseline be established. 
The project can then record updates chronologically from any time after the start date. We 
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recommend users select a frequent and consistent time interval for status updates 
(perhaps weekly or semi-monthly?) so that the corresponding graphics are uniform and 
intuitive. 

For the first update in the tutorial, perform the following steps: 

1) Select the “Project Progress Update” button from the Chrono™ Tools ribbon. 

 
Figure 41 Project Progress Update Button to Initiate Wizard 

2) Enter 2/28/2020 5:00 PM in the Set Status Date input box and click on the “Set 
Status Date” button. Note the Status Date will now be updated in the dialog. 

 
Figure 42 Project Progress Update Dialog & Input Box – Pre-Update 

3) Select the button “Update Tasks” on the dialog. 

4) The update tasks dialog displays the time remaining for each task that requires an 
update. For this tutorial, change the remaining days on TaskID #3 from 25 to 35 days 
and hit “Next”. This change indicates that an issue has impacted the schedule of 
TaskID #3 causing a delay. 



  Improved Decision Making  

©2023 RTConfidence, Inc. V2.4  Page 41 

5) A child window will be displayed asking if you wish to accept the recalculated Best-
Case and Worst-Case values.  For our tutorial, click “Accept Changes” without 
further edits: 

 
Figure 43 Best-Case and Worst-Case Adjustments Window 

6) Click the “Preview” button to view the changes to the project and determine if 
additional changes may be necessary. The dialog will automatically exit and the 
TriCoBi™ simulation will be run so that you can observe the results of the update. 

7) For purposes of the tutorial, we will make one more change.  While you are learning 
to use Chrono™ you may find the wizards helpful.  Once you are familiar with the 
tool, you may find it more convenient to update the data in Microsoft Project® 
directly.  Change the duration of TaskID #8 from 20 to 30 days in the duration field 
of the task in Microsoft Project®. This change indicates that a second issue has 
negatively impacted the schedule.  

8) Click the “Run TriCoBi™ Simulation” to manually preview how the changes have 
impacted the timeline. 

9) Publish the schedule when satisfied with the updates by clicking on the “Project 
Progress Update” button and then clicking on the “Publish” button. 
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Figure 44 Project Progress Update Dialog & Input Box – Post-Update 

 
10) Choose “Yes” on the accept change warning dialog. The screen will flash as a backup 

file is stored for future reference. Notice the backup files created with setting 
baselines and publishing have a naming convention that extends the original file 
name with three digits, such as “Tutorial Project #2_000.mpp”, “Tutorial Project 
#2_001.mpp”, Tutorial Project #2_002.mpp”, etc.  
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UNDERSTANDING WHAT ESM AND CHRONO™ REFLECT ABOUT 
STATUS 

1) Choose to display the probability chart and see how the commit confidence-level 
has been lowered and the 70% goal confidence-level date has been extended. 

 
Figure 45 Primary Simulation Output - Commitment Milestone 

 

 
Figure 46 Distribution Output Data Box 

2) Next, check on the Distribution Trend chart. Note the new bar on the right 
represents the update. 
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Figure 47 Distribution Trend Showing Baseline and First Status Update Data 

3) Next, check on the Earned Schedule Management (ESM) charts. Remember these 
charts have the built-in leading indicators that go beyond the 3-point estimate 
probability distribution and use the velocity calculated from the most recent status 
update to forecast the project end date at the given confidence level.  

Earned Schedule Management is about forecasting the future based on current trends. 
When a project starts to slip, the project’s change in velocity is reflected in the 
Schedule Performance Index value shown in the charts below.  An SPI value of 1.0 
means the project is running at the velocity originally estimated and reflected in the 
project baseline. Since we have both goal-baseline and a nominal baseline, we have 
corresponding SPI values. 

When measuring project performance for important business deadlines, we 
recommend tracking SPI on a weekly basis. SPI values of 1.0 or greater means that the 
project is tracking to meet or beat the business commitments. SPI values of less than 1.0 
mean that the project has begun slipping and the recovery plan should be put in place 
as soon as possible. The reason it’s always urgent to start a recovery plan when SPI is 
less than one is because changes in schedules are always least expensive early in the 
project rather than late in the project. More to the point, if project slips are not 
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detected and acted upon early in the project, it becomes increasingly difficult to 
recover the schedule. 

An added benefit of monitoring SPI is that first-line managers and project leads have 
found that they can use the SPI factor to identify subtle issues like employee 
engagement and hidden project complexity issues that might not be verbalized by 
their teams. 

In tutorial data entered above, TaskID #3 and TaskID #8 were both extended by 10 days 
each during the first 4 weeks of the project. Note how this negative performance has 
extended the burn-up for the Goal Projected line.  The total project duration is now 
estimated at over 500 days.  The project is not off to a good start. 

 
Figure 48 Goal Baseline vs. Projected Earned Schedule Chart after First Update 
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You can access Schedule Duration Estimates and Schedule Performance Index (SPI) 
values from the vertical tabs along the left side of the Earned Schedule tab of the 
browser display.  Note how the SPI has changed from the neutral starting position of 1.0 
downward to 0.87 for the Project Goal. The result is an ESM forecasted extension of 43 
business days to the project - creating an ESM projected end-date of May 5, 2021. 

Check that again, the SPI factor predicts that a 10-workday slip on two separate tasks 
early in the project results in a 43-workday slip in project completion. The message is to 
monitor SPI closely to keep steering the project to the targeted goal dates similar to 
how a sailor might monitor their compass or GPS to stay on course to their destination.  

 
Figure 49 ES Total Time Baseline and Projected Metrics after First Update 
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Figure 50 ES SPI (Schedule Performance Indicators) Metrics after First Update 

4) After seeing the negative performance of the project with the ESM leading 
indicator, the project manager will need to consider some early and aggressive 
actions to recover the schedule and get the trend back on track to the original 
forecasted 70% confidence date. The impact of this schedule recovery action will be 
shown in the next project update. 

5) Select “Project Progress Update” and set the date to 3/27/2020 5:00 PM. 

6) Select “Update Tasks”. 

7) Change the remaining dates on TaskID #3 from 15 to 10 due the results of the 
project manager’s aggressive recover plan.  

8) Accept the remaining dates for TaskID #4. 

9) Select “Publish” and choose “Yes” on the accept change warning dialog. 
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10) See the distribution chart showing that the Commit confidence has recovered and 
is now over 74% based on the original end-date of 3/4/2021. 

 
Figure 51 Output Distribution after Second Update 

 

 
Figure 52 Output Data Table after Second Update 
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11) Check the Distribution Trend to view the changes in the Commit confidence-level.  

 
Figure 53 Distribution Trend Chart after Second Update 

12) Next, check on the Earned Schedule Management (ESM) charts to see how well the 
project manager’s recovery plan worked using the SPI as the primary lead indicator. 

13) See that the updated Goal Project is now within the Goal Baseline on the burn-up 
chart. 

 
Figure 54 Goal Baseline and Projected after Second Update 
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The SPI has changed through the aggressive action of the project manager from 0.87 to 1.02 
resulting in a new ESM forecasted end date of 2/25/2021. 

 
Figure 55 End Date and Time Projections vs. Baselines 

Ideally, the project manager will now continue to monitor the Goal SPI and the ESM 
forecasted end-date and as much as possible take the actions required to keep SPI equal 
or greater than 1.0 and to keep the ESM forecasted end-date near or earlier than the ESM 
Goal Baseline target of 3/5/2021. 

 
Figure 56 SPI (Schedule Performance Index) Trends for Nominal and Goal 
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CAVEATS TO TRACKING WITH EARNED SCHEDULE 
MANAGEMENT  

In some cases, tracking a project strictly with ESM can miss some critical information. The 
ESM computation can include in its calculations the tasks that are not on or near the 
critical path but are trending significantly late per the project baseline.  

Until these non-critical path tasks slip so late that they become critical path or near critical 
path tasks, then they would not impact the schedule end date. However, they would 
impact the SPI of the ESM. Therefore, if the ESM schedule forecast end date is moving out 
because of these non-critical path items, then there are two options to consider helping 
determine a more accurate forecasted end date. The first is to re-baseline the schedule and 
reset the timing on the non-critical path items to match the current trends. The second is 
to balance the ESM schedule forecast with the probabilistic estimation forecasted end 
date. 

CAVEATS TO TRACKING WITH ONLY A PROBABILISTIC 
SCHEDULE END DATE 

It is also important to understand the limitations of tracking a project by the probabilistic 
end date created from the original 3-point estimates. While this forecasted end date is 
kept current with each Project Update entry, it does not provide an update to the project 
velocity. The project velocity represented in the probabilistic schedule end date is the 
original project velocity from the planning stage of the project. 

Therefore, if the project velocity significantly changes after the project start date, it will be 
important to make sure the SPI for ESM remains valid by carefully monitoring the caveats 
for ESM. If the project velocity significantly changes for any reason and it is not possible to 
keep the SPI accurate, then it would be best to re-evaluate the remaining 3-point 
estimates and re-baseline the project. 

RE-BASELINING THE SCHEDULE 

If at any point the project charter or plans change significantly enough for the original 
schedule to no longer be valid, then the updated project schedule should be re-baselined.  
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A two-step process is recommended to re-baseline a schedule. The first step is to duplicate 
the project schedule using the Chrono™ customized “Save As” function in Microsoft 
Project®. The second step is to use the “Set Project Baselines” function in the Chrono™ Tool 
ribbon to set the baseline. It is important to understand that the both the ESM values and 
the cloud-based history of the project will be cleared when re-baselining as schedule. The 
principal option when re-baselining a schedule is whether or not to keep the percent 
complete values for each task.  

Typically, when re-baselining, the percent completes for each task are retained. If a project 
is being used as a template for a new project, then it is typical to clear the task progress.   

Re-baseline the project schedule with the following steps: 

1) “Select File > Save” to save the project file to confirm that the original file is 
preserved. 

2) “Select File > Save As” to create a new project file to hold the re-baselined project 
schedule. Use the file name “Tutorial Project #3.mpp”. 

3) Select the “Retain” option in the “Save As” dialog for the purposes of creating a re-
baselined project schedule. 

 
Figure 57 Options for Clearing IMS Data 

4) Select “Run TriCoBi™ Simulation”. 

5) Choose “Goal Confidence” on the Chrono™ Gantt Chart Views ribbon. 
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6) Click the “Align Commit” button on the Chrono™ Gantt Chart Views ribbon and 
choose “Yes” for End of Day. 

 

 
Figure 58 Sequence for Aligning the Commit Milestone 

7) Note that the “Run TriCoBi™ Simulation” button in the Chrono™ Tools ribbon has the 
yellow warning triangle signifying that the TriCoBi™ Simulation needs to be run 
again. 

 
Figure 59 Simulation Button's Warning Triangle 

8) Re-run the TriCoBi™ Simulation. 

9) Select “Set Project Baselines” button on the Chrono™ Tools ribbon. 

 
Figure 60 Set Project Baselines Button 

10) Select “Yes” to the sponsor approval question. 
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Figure 61 Precaution Pop-up for Changing Baselines 

11) The screen will flash as an additional backup file is stored for the baselines. 

12) Baselines are set for both the Nominal Durations and the Goal Confidence 
Durations. 

13) The TriCoBi™ Simulation is rerun. 

14) Choose to see the web graphics. 

15) See that the baseline is set in the top right side of the header. 

16) See the updated project end-dates for each confidence level. 

 
Figure 62 Simulation Output Data Box  
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Risk-Adjusting the Committed IMS to Ensure Success 

There will likely be times when you or someone working for you either: 
1. Made a project schedule commitment based on single-point estimates (i.e., the 

Nominal Critical Path task estimates) prior to performing an SRA (Schedule Risk 
Analysis), as in our earlier example schedule, and discovered that the % confidence 
in meeting that commitment timeline is very low, so you and your team must try to 
somehow change the schedule to arrive at a higher level of confidence to appease 
the project stakeholders – and to give you and your team a much more realistic 
chance of being successful. 

2. Have been given the difficult task of managing a project with a very challenging 
commitment timeline, and your first attempt at constructing the schedule shows 
that, based on 3-point estimates from subject matter experts, the chance of  
meeting the commitment date is very low (i.e., the resulting % Confidence is very 
low [less than 5%] and just barely enables the schedule commitments to be met). 

So, what do you do?  If schedule is that important, you must evaluate other options, i.e.: 
A. Breaking the Risky Tasks up into Parallel Activities where Possible 
B. Re-Sequencing of Risky Activities (i.e., Changing the Task Network) 
C. Adding More Resources to Certain Tasks 
D. Paying for Expedited Delivery of Materials 
E. Adding More Funds for Additional and/or More Capable Resources 
F. Changing Product Requirements to Necessitate Less Scope of Work 
G. Outsourcing Some of the Scope of Work to Outside Contractors/Specialists 

Some examples of tasks that tend to be riskier are shown below. 
• Design Activities and System Integration, (e.g.: Merging of Multiple Technologies, 

Components and/or Sub-Systems) 
• Test Activities – Especially Early Validation or Qualification Tests 
• Approvals or Authorizations to Proceed 
• Design-Build-Test Cycles 
• Out-door Work, due to Weather 
• Out-sourced Activities and Critical External Resources, (e.g.: Key / Critical Parts, 

Subject Matter Expertise, and/or Scarce Fabrication or Test Facilities) 
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RISK ADJUSTING THE NOTIONAL IMS 

The project team has the following dilemma to work out: 

 
Figure 63 Notional IMS Results After 3-Point Estimates Applied 

The team in this notional example tried different changes and kept rerunning the TriCoBi™ 
simulation to evaluate the effectiveness of the adjustments.  They started off by first 
taking advantage of some key data provided by the Chrono™ output. 
The first action taken was to find out exactly how many workdays would have to be 
removed from the Critical Path, if that was the only avenue for improving the schedule 
(another important option is reducing the risk, thus the worst-case durations as well) to 
effectively move the distribution curve to the left.  To help you out with this, Chrono 
provides some useful data as described below: 

1. If you hover your cursor over the green “Goal Confidence” box on the output 
distribution as show in the subsequent figure, you get the pop-up box as shown in 
the middle of the chart.  The data shows that your current “Commit Confidence” 
highlighted in blue is 47.6 workdays from the “Goal Confidence” date.  By taking 
proactive IMS risk reduction actions (i.e., implementing some of the changes listed 
above), your team can improve overall project % confidence in meeting the 
schedule commitment date of 3/4/2021. 
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Figure 64 Original Schedule Distribution Chart 

2. The Tornado chart shown below is another helpful tool to use when working with 
very large schedules.  This chart displays (from Top to Bottom) the tasks with the 
most risk (i.e., those tasks with the longest time between worst-case and nominal 
duration estimates).  You team can potentially revisit these activities and determine 
what other actions could be implemented to bring those risk levels down. 
 

 
Figure 65 Example of Tornado Chart Output 
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PROACTIVE RISK MANAGEMENT CHANGES 

As a result of this proactive risk reduction activity, the project team made the following 
changes to the IMS – this is documented in a way to enable you to follow along, however, 
if you would like to skip this process, you can go directly to the next section (here) and 
input the changes as shown in the tables provided. 

A. Make the following changes to break up the Prototype activity and perform tasks in 
parallel 

1. Change Task 4 from “Buy Prototype Parts” to “Buy Prototype LL (Long-Lead) Parts” 
2. Add New task “Buy Remaining Prototype Parts” after task 4 
3. Change the next Task, “Prototype Build” to “Initial Prototype Build” 
4. Add New task “Final Assembly of Prototypes” after “Initial Prototype Build” 

B. Make the following changes to break up the POR (Plan of Record) Unit activity and 
perform tasks in parallel 

1. Change “Buy Parts for Qual Units and Production” to “Buy LL Parts for Qual Units and 
Production” 

2. Add New task “Buy Remaining Parts for Qual Units” after above task 
3. Change “Assembly of POR (Plan of Record) Qual Units” to “Initial Assembly of POR (Plan 

of Record) Qual Units” 
4. Add New task “Final Assembly of POR Units” after “Initial Assembly of POR (Plan of 

Record) Qual Units” 

C. Make the following structural changes to include the appropriate overlap by changing 
Interdependencies (i.e., the Predecessors and Successors):  

1. Change Task 3 Successor to “4SS+30days, 5” – this enables ordering of LL Parts earlier, 
then the Remaining Parts (that are likely to change after the Design is complete) 
separately. 

2. Give Task 4 a 35day Duration and give Task 5 a 30day Duration with Task 7 as its 
Successor.   

3. Give Task 6 a 20day Duration with Task 7 as its Successor.  
4. Give Task 7 a 10day Duration and make Task 8 its Successor. Now the parts procurement 

and assembly activities are overlapping to help the schedule. 
5. Now we are going to improve schedule by having Task 10 (Final Product Design) start 15 

days after Task 8 (Test & Evaluation) starts by changing Task 8’s Successor to 
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“10SS+15days, 12” – the “, 12” is to link its finish to the start of buying LL Parts for 
Qualification Units (Task 12). 

6. We can now decouple the buying of LL Part for Qual Units from the Design Review 
(Task 11), and tie completion of Task 11 to buying the remaining parts (Task 13). 

7. Change Task 11’s Successor to Task 13.  Change the Duration of Tasks 12 and 13 to 30days 
with Task 15 (Final Assembly of POR Qual Units) as the Successor of Task 13 and 14.  

8. Change Task 14’s Duration to 20 days, and Task 15’s Duration to 15 days.  Since Task 15’s 
completion drives Qual Testing, make its Successor 16.  Change Task 16’s Successors to 
18, 19.  

9. Task 17 (Verify Final Design Iterations) can start when the first units are Assembled (2 
weeks after Final Assembly), so make its Predecessor 15SS+10days and change its 
Duration to 30days. 

D. Make the following 3-point estimate changes (i.e., Best-Case and Worst-Case duration 
estimates):  

1. Change Task 4 WC to 0 (from 64days) – Note that “0 days” in the BC and WC columns 
equates to the “Duration” value with BC and WC equal to Duration. 

2. Change Task 5 WC to 40days (from 0days – since it is a new task), Task 6 BC to 15 (form 
25 days) and WC to 25 (from 40days), Task 7 BC to 8 and WC to 20days (from 0 and 0 – 
since it is a new task) 

3. Change Task 8 WC to 40 (from 30), Task 10 no changes, Task 12 WC to 0 (from 40), Task 
13 WC to 40 (from 0) 

4. Change Task 14 BC and WC to 15 and 25 (from 8 and 20), Task 15 BC to 8 and WC to 20 
(from 0, 0 since it is a new task), Task 16 no changes, Task 17 no changes, Task 19 no 
changes. 

 

THE FINAL RISK-ADJUSTED IMS 

Check the result of your changes with the data in the following tables to ensure that they 
are indeed correct.  This will enable you to directly compare your outputs to those in this 
document (the outputs should be identical). 
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Task ID Task Name Duration Predecessors 
1 Start Milestone  0   
2 Prototype Development     
3    Prototype Design 45 1 
4    Buy Prototype LL (Long-Lead) Parts 35 3SS+30 
5    Buy Remaining Prototype Parts 30 3 
6    Initial Prototype Build 20 4 
7    Final Assembly of Prototypes 10 5,6 
8    Test & Evaluation 20 7 
9 Final Product Development     
10    Final Product Design 35 8SS+15 
11    Final Design Review 0 10 
12    Buy LL Parts for Qual Units and Production 30 8 
13    Buy Remaining Parts for Qual Units 30 11 
14    Initial Assembly of POR (Plan of Record) Units 20 12 
15    Final Assembly of POR Units 15 13,14 
16    Conduct Qual Tests 20 15 
17    Verify Final Design Iterations 30 15SS+10 
18 Conduct Launch Readiness Review 0 16,17 
19 Buy Remaining Production Parts 30 16 
20 Start Production   18,19 
21 Commitment Milestone   20 

Figure 66 Source Data for Risk-Adjusted Schedule 
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Task ID Task Name Best-case 
Duration 

Nominal 
Duration 

Worst-case 
Duration 

3    Prototype Design 40 45 60 
4    Buy Prototype LL (Long-Lead) Parts 35 35 35 
5    Buy Remaining Prototype Parts 30 30 40 
6    Initial Prototype Build 15 20 25 
7    Final Assembly of Prototypes 8 10 20 
8    Test & Evaluation 15 20 40 
     

10    Final Product Design 30 35 50 
     

12    Buy LL Parts for Qual Units and Production 30 30 30 
13    Buy Remaining Parts for Qual Units 30 30 40 
14    Initial Assembly of POR (Plan of Record) Units 15 20 25 
15    Final Assembly of POR Units 8 15 20 
16    Conduct Qual Tests 15 20 50 
17    Verify Final Design Iterations 20 30 40 
     

19 Buy Remaining Production Parts 30 30 40 
Figure 67 Project Data Table for 3-point Estimate Inputs 

 

 
Figure 68 Revised Nominal Durations (Critical Path) Gantt Chart 



  Improved Decision Making  

©2023 RTConfidence, Inc. V2.4  Page 62 

Why Traditional Schedules Fail: Basics of Schedule 
Risk Management 

The Problem 
We have something we need to accomplish.  We build a to-do list of the steps, develop 
credible estimates, commit arithmetic, and determine the approximate time required to do 
the project.  We often find the project takes longer than we predict.  The process seems 
reasonable, why are we late so often?   

The answer is risk.  This article explores how estimation risk affects a schedule and what 
you can do to create better schedules and more effectively communicate schedule risks to 
executives. 

A simple example project to illustrate:  Imagine you have been hired to frame and pour the 
foundation for a house being constructed.  Let’s assume you identify the following tasks 
and believe that the estimates for the task are reasonable: 

Project – Create Slab House Foundation: 

A) Get Materials (2 days) – obtain wood and pipes for framing and plumbing 
B) Frame Foundation (5 days) – build wooden frame to pour concrete into 
C) Install Plumbing (5 days) – place drains & sewage pipes prior to cement pour 
D) Pour Foundation (3 days) – pour cement and wait for it to cure 

 
Figure 69 Basic Network Diagram 

Assume these estimates are reasonable.  Assume we have the resources to run tasks B & C 
in parallel.  How many workdays will it take to finish the project?  
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D1 D2 D3 D4 D5 D6 D7 D8 D9 D10 
Get Materials         

  Frame Foundation    
  Install Plumbing    
       Pour Foundation 

 
 
 
 
We can do the math to calculate an end date, but our experience says this will often be 
optimistic, particularly as projects get larger and more complex.  Why?  The estimates are 
reasonable.  We are following traditional scheduling practices.  What are we missing? 

The estimates are reasonable, but how likely is it that these tasks take EXACTLY the 
amount of time we estimated.  Pretty rare.  Some might take a day longer or a day less.  We 
might be able to get all the materials in a single day, or a part we need might be out of 
stock.  One of the workers might get sick.  Rain might delay concrete curing. 

A number of problems could delay the tasks in even this simple project.  Is it a problem 
with the estimates?  Not really.  Estimates are predictions based on the best information 
available when we make them.  We don’t have perfect information about the future, so we 
make what we hope are reasonable assumptions about the availability of materials, the 
productivity of the team, and the availability of concrete.  Things might go a little faster or 
might take a little longer, but we call them “estimates” rather than “accurate predictions of 
the future” because we know there is uncertainty in all predictions. 

Risk = uncertainty  
Let’s look specifically at tasks B and C.  We estimated that these would each take 5 days 
and that they could be done in parallel.  There may be a problem hiding here.  If the same 
people are doing both tasks, having the tasks occur in parallel assumes that people can be 
in two places at once. Even if your estimates were good, you may already be in trouble.  
These estimates depend upon some general assumptions about resource availability, 
materials, humans, and cement mixers. 

10 Days 

Figure 70 Simple Project Timeline 
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There is a subtle structural problem that may come into play as well.  Note that we have 
depicted that both tasks B and C must be complete before you can pour the foundation.  
When a task like Pour Foundation is dependent upon multiple predecessors, we describe it 
as a “merge node” in the task network.   

Merge nodes must wait for all of their predecessors to complete, which increases the 
chances they will be late because any of the predecessors that run late cause the merge 
node to be late.  Merge nodes play the unfortunate role of amplifying schedule slippage 
through a task network.  This effect is surprisingly significant. 

Imagine that estimates for tasks B & C both have a 50% chance of being “right” – 
predicting the date on or before the task will complete.  That says there is a 50% chance of 
exceeding the estimate – that translates into a 75% chance that task D starts late, as 
shown in the following picture: 

 
Figure 71 Merge Node Effects 

Why Not “Pad” the Estimate? 
Our first instinct is often to “pad” the estimates.  We imagine it will take 2 days to get our 
materials, but we call it 3 days “just to be sure”.  We think it may take 5 days to frame the 
foundation, but we call it 7 to avoid being responsible for the schedule slipping.  Sadly, 
padding our estimates like this can hurt us in several ways: 

1) An executive who thinks our end date is too far in the future and discovers obvious 
padding may deduce that we are either incompetent or lying.  “Seven days to frame 
a foundation?  In MY day we could do that in 4 or 5.” 
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2) It may result in poorly informed business decisions that cause us to lose the 
business.  The client may say, “I wanted to go with contractor X, but their schedule 
said this was going to take 15 workdays and contractor Y says they can do it in 10.” 

3) If we can complete a task sooner, we may not be able to take advantage of the 
windfall because resources to do the other tasks aren’t scheduled to be available.  If 
we can frame the foundation and get the plumbing installed in 5 days, but we 
padded the schedule to 7, then the cement mixer we scheduled may not be able to 
shift to earlier delivery. Padding may seem like a natural solution, but it causes more 
problems than it solves. 

A Better Approach to Estimates 

Developing credible estimates is hard. It asks us to make informed guesses about the 
product we are building, the team that is building it, and the future context in which it will 
be built. These are all uncertain. 

Here’s a counterintuitive solution: Instead of asking for one estimate predicting the cost 
and schedule of a piece of work, ask for three: 

1) Best Case - If you did tasks of similar size & complexity 10 times, what is the best 
realistic case you can imagine (e.g., things don’t go perfectly, but they go 
smoothly)? 

2) Likely/Nominal Case - What is your best guess about the time and resources 
normally be required to perform a task of this size and complexity?  

3) Worst Case - If you did similar tasks 10 times, what would likely be the effort and 
duration of the most frustrated of your 10 attempts? What estimate do you feel 
very confident you can deliver, absent significant drama? 

The three-point estimate relieves the team from the pressure of trying to accurately 
predict the future and instead asks for a range of possibilities they think are credible, based 
on their experience and the best information available. 

This reinforces for both the estimator, and anyone reviewing the estimate that estimation 
is not an exact science. It also calls attention to tasks where the team has a great deal of 
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uncertainty, as defined by tasks with a large spread between the best and worst case. This 
method fosters a conversation about what, if anything, can be done to reduce that 
uncertainty (prototyping, further research, more design) prior to providing information to 
executives. 

Remember, these are estimates, not hard and fast predictions of the future. In the hands of 
responsible decision-makers, thoughtful estimates can do a lot to identify risks and set 
expectations. 

Visualizing 3-Point Estimates 
Let’s go back to our foundation example and show you how the results of 3-point 
estimates can be shown to executives to better communicate schedule risk.  The same task 
list is presented below.  I have included estimates for best case, likely case, and worst case. 

Project – Create Slab House Foundation: 
A) Get Materials (1,2,3 days) – obtain wood and pipes for framing and plumbing 
B) Frame Foundation (4,5,8 days) – build wooden frame to pour concrete into 
C) Install Plumbing (3,5,9 days) – place drains & sewage pipes prior to cement pour 
D) Pour Foundation (2,3,7 days) – pour cement and wait for it to cure 

 
Figure 72 Network Diagram 

If we assume the best case when we build our schedule, we get a duration of 7 days – this 
is overly optimistic because it is unlikely that everything would go so smoothly for all four 
tasks, but it describes the absolute soonest we can imagine the project being competed 
with the resources assigned.   

If we show the likely case, we get a duration of 10 workdays - the same as the earlier 
schedule, which experience says would be a challenge and likely late.   
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If we show the worst case, we get a duration of 19 days - and we have the same problems 
we described above for padded estimates. 

Let’s visualize the duration of each task as a probability distribution (a curve showing likely 
outcomes)?  The tasks might look like this: 

Get Materials (1,2,3) 
 
 
 
 
 
 
 
 

D1 D2 D3 D4 D5 D6 D7 D8 D9 D10 
Figure 73 3-Point Timeline Estimate for Get Materials 

Finishing by the end of day 1 is possible, but very unlikely.  The most likely estimate would 
be to finish at the end of day 2.  Interesting to note that half of the outcomes shown by 
this curve occur in day 3, although it appears unlikely that all of day 3 would be required to 
complete the task. 

Frame Foundation (4,5,8) 
 
 
 
 
 
 
 
 

D1 D2 D3 D4 D5 D6 D7 D8 D9 D10 
Figure 74 3-Point Timeline Estimate for Frame Foundation 

Best Case Worst Case Nominal Case 

Best Case Worst Case 
 

Nominal Case 
 

Likelihood 
Likelihood 
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Note that most of this shape represents that task finishing after day 5.  This might prompt a 
question about what the estimator imagines might go wrong that would lead to this delay 
(like bad weather), but we will explore that later. 

Install Plumbing (3,5,9) 
 
 
 
 
 
 
 
 

D1 D2 D3 D4 D5 D6 D7 D8 D9 D10 
Figure 75 3-Point Timeline Estimate for Install Plumbing 

 
Pour Foundation (2,3,7) 
 
 
 
 
 
 
 
 

D1 D2 D3 D4 D5 D6 D7 D8 D9 D10 
Figure 76 3-Point Timeline Estimate for Pour Foundation 

These images help visualize the problem with single point estimates.  Although the likely 
case may be a reasonable estimate, there are many outcomes that exceed it. 

A key idea here is that some tasks might finish early, but it is unlikely that ALL tasks will 
finish early.  Some tasks may exceed their expected duration, but if the estimates are 

Best Case Worst Case 
 

Nominal Case 
 

Likelihood 

Best Case Worst Case 
 

Nominal Case 
 

Likelihood 
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credible, it is unlikely that they ALL extend to the maximum “High Confidence” boundary.  
It would be helpful to combine the information from the 3-point estimates of all four tasks 
into something that we could show an executive to help them understand when the 
project was likely to be complete. 

(Drum roll please…) 

We can do this with a mathematical process called a “Monte Carlo Simulation”.  Without 
going into the math, this is like hiring a thousand identical teams to do the same project a 
thousand times and graphing the resulting completion times. 

 

Figure 77 Simulation Output Distribution 

As you can see above, the output of this simulation shows the approximate likelihood of 
achieving various project completion dates.  The left vertical access describes the 
frequency of the date bars of the histogram.  If you look at the histogram bar for 5/15 you 
will see that it occurred about 5% of the time in the simulations.  The right vertical access 
describes the cumulative probability of achieving the date corresponding to the purple 
line.  If you look at the 50% mark and go left, you will see the purple line on 5/19, meaning 
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that the schedule extended beyond 5/19 about 50% of the time and finished on or before 
5/19 about 50% of the time. 

Our project began on May 5th and the best-case scenario would be the project finishing in 7 
days at the end of the day on May 14th or start of May 15th (my example schedule assumes 
we are working 8 hours per day 5 days a week - the 7 days of work would occur on May 5, 
6, 7, 8, 11, 12, 13, 14 & 15).  None of the simulations finished before the 14th.  Clearly assuming 
the best case for all tasks is overly optimistic. 

Remember the initial schedule we built with the first set of nominal estimates?  Those 
were the best honest predictions of the team and traditional scheduling suggested the 
project would finish at close of business on the 15th.  The simulation only saw that outcome 
or better (right axis) about 5% of the time.  Our intuition that this wasn’t enough time 
seems correct.  

What about the late outcomes?  Although normal scheduling techniques would suggest 
that 5/15 was the projected end date, over 17% of the end dates in the simulation finish on 
or after 5/21, four or more days after our projected end date. 

How is this helpful? 
Remember that we went down this rabbit hole trying to honestly answer the question, 
“When will the foundation be ready?”  We agreed that estimates were difficult and rarely 
accurate and were trying to find a better way to predict the end date without arbitrary 
padding.  When we asked the team for 3-point estimates, they were able to give us their 
best honest guess (likely case), as well as the best case and the high confidence estimate 
to establish boundaries and help us understand the variability they predict based upon 
their experience. 

Using this data to create the chart, we can now have a conversation about schedule risk.  Is 
it possible we could do the project by 5/14?  Yes, but it is extremely unlikely; less than a 1% 
chance.  We now have a visual aid for the project sponsor.  According to the chart about 
80% of the time we expect the project to complete on or before 5/21, barring 
circumstances we can’t anticipate.  This allows a sponsor to discuss how much risk they are 
willing to take. 
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For example, if the plan calls for an expensive crew to show up to build the building once 
the foundation is complete and they must be paid whether the foundation is in place or 
not, the sponsor can decide whether to risk having them show up May 15th (95 percent 
chance of missing that date) or schedule them for May 20th (70% chance of the foundation 
being complete). 

The process that culminates in this chart helps to communicate the uncertainty of the 
schedule prediction much more effectively than specifying a specific date.  If you were 
relying on someone to tell you how long they thought a project was going to take, would 
you rather they gave you a date or initiated a conversation about likely dates and 
confidence levels? 
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Using 3-Point Estimates for Less Stressful, Better 
Quality Estimates 
Estimates are needed to inform decision-makers about whether it is worth solving a 
problem as it is currently understood. It might seem counterintuitive, but instead of asking 
for one estimate of cost and schedule, ask for three. Here's an approach to doing that and 
an explanation about why it might be more informative and less stressful. 

Although we disagree with the fervent #noestimates crowd about several of their 
arguments, they make some valid points. In a world where the ultimate project outcome is 
not clearly defined up front and a project is an exercise in discovery, the notion of “precise 
estimates” is laughable.  

We part ways when people assert that no estimate is better than a crude one. 

If our car starts acting strangely and we take it to the shop, we expect one of two 
conversations: 

1) The service rep recognizes the problem and can tell me with 80% confidence about 
how long it will take and what it will cost to remedy the problem, assuming their 
prediction about the problem is correct and no other issues are discovered. 

2) The service rep looks puzzled, says, “There are several things that could cause that,” 
and suggests a cost and time estimate—not to resolve the problem, but to diagnose 
it. 

Estimates serve a number of purposes, but one of the most important is to inform 
decision-makers about whether it is worth solving a problem as it is currently understood. 
How would you feel if the service rep said, “I don’t know what the issue is, but give me 
your credit card and we’ll start diagnostics.  I’ll call you if we figure out the cause!”  

Developing credible estimates is hard. It asks us to make informed guesses about the 
product or service we are building, the team that is building it, and the future. These are all 
uncertain—for instance, I doubt any of the project managers I coach had “unexpected 
quarantine” on their “assumptions about the future” bingo card, but here we are. 
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Here’s a counterintuitive technique: Instead of asking for one estimate predicting the cost 
and schedule of a task, ask for three. Three-point estimates are more useful and usually less 
stressful than their single-point alternative. 
Here are the three prompting questions to get your team started: 

1) If your team performed tasks of similar size and complexity 10 times, what is the 
best realistic case you can imagine in terms of time and resources (e.g., things don’t 
go perfectly, but they go smoothly and well)? 

2) What is your best guess about the time and resources that would normally be 
required to perform this task?  If we imagine doing the task 10 times, this would be 
the most likely outcome in terms of time and cost. 

3) What would likely be the effort and duration of the most frustrated of your 10 
attempts? What is the longest you can imagine it taking, absent some external 
drama?  What are some of the things that could go wrong that would drive the 
worst case? 

The opportunity to provide three-point estimate relieves the team from the pressure of 
trying to accurately predict the future and instead asks for a range of possibilities they 
think are credible, based on their experience and the best information currently available. 

This approach reinforces that estimation is not an exact science. It also encourages a 
conversation about risk – uncertainty the team has about the task and things that could 
drive it toward being late.  Uncertainty is underscored for tasks with a large spread 
between the best and worst case. This gives project managers and team leaders 
opportunities to discuss what might be done to reduce that uncertainty (prototyping, 
further research, more design). 

Using schedule risk management tools like Chrono™, three-point estimates, particularly for 
high-risk tasks – tasks with a significant variance between the best-case and worst-case 
estimates – helps create more realistic schedules.  
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The DCMA 14 Point Metrics Check 
Some schedules represent credible task logic and can be used for tracking progress, and 
some are art projects that may be pleasing to the eye but are mostly worthless.  Tired of 
dealing with vendors and programs that were trying to manage complex and expensive 
efforts using art projects, the US Defense Contract Management Agency (DCMA) 
developed and distributed objective criteria for evaluating schedules both quantitatively 
and qualitatively in 2005. 

The metrics were adopted first by the US Department of defense (DOD), and are now 
required of their subcontractors by some major defense contractors.  While not hard and 
fast rules, schedules that comply with the guidelines tend to be more credible and 
manageable, and schedules that do not comport with the guidelines are unlikely to be 
useful for understanding or tracking changes in a credible way. 

Chrono™ provides a mechanism to assess compliance with the DCMA 14-Point assessment.  
This chapter explains the standard and how Chrono™ users can review the assessment of 
their schedule.   

1. Logic – It’s generally considered best practice for all tasks in a schedule to have at 
least one predecessor and at least one successor.  This does not include summaries 
or milestones.  The actual test looks at tasks that are not marked 100% complete to 
have at least one predecessor and one successor.  The threshold for compliance is 
that no more than 5% of tasks should be without both predecessor and successor.  
It is a good rule of thumb that all tasks have predecessors and successor. 

2. Leads – This metric measures the percentage of tasks that have a negative lag 
between them.  An example would be task B scheduled to start 3 days before the 
end of task A.  Although most scheduling tools allow this, using leads confounds 
efforts to calculate project float (or slack) and the critical path.  The standard is that 
no tasks should have leads.  Usually when someone suggests a lead is needed, tasks 
can be further decomposed so that traditional Finish to Start relationships can 
capture and better represent task logic. 

3. Lags – The Lag metric is the percentage of project tasks that have a positive lag 
between them.  Lag is a positive delay on a dependency.  If we said task B can start 
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3 days after task A finishes, then we have defined a 3-day lag between A and B.  The 
threshold for this metric is no more than 5% of all task relationships should contain 
lags.  A better practice is to have a named task in the dependency chain to explain 
what is being waited for; for example, perhaps Task A was to paint the table and 
Task B was to set the table.  Inserting a 3-day task for “Dry the Paint” between the 
two would eliminate the lag and better document the task logic.                                                                                                                                                                            

Although a lag between finishing task A and starting task B is not advised, starting 
task B “x” days after task A starts (a Start-to-Start relationship type) is more 
acceptable provided “x” is not greater than the task A total duration. 

4. Relationship Types – The metric is the percentage of all project tasks that use 
Finish to Start relationships.  Most schedule logic can be represented with Finish to 
Start dependencies, but in some circumstances Start to Start and Finish to Finish 
dependencies may be appropriate; for example, a quality assurance task may not be 
able to start until the work being assessed has begun.  The threshold for this metric 
is 90%.  No fewer than 90% of the relationships in the schedule should be Finish to 
Start. 

5. Hard Constraints – A hard constraint is a specified fixed date for a task to begin or 
end (Must Finish on, Must Start On).  Hard constraints can mask 
progress/performance issues and thwart schedule analysis because they stop a 
schedule from responding to delays of predecessors.  The metric is the number of 
unfinished tasks with hard constraints.  The threshold is that no more than 5% of 
incomplete activities in the schedule may use hard constraints. 

6. High Float – This metric measures the percentage of unfinished tasks that have 
total float greater than 44 working days.  While high float might be a good indicator 
that there is slack in a schedule, it can also indicate that task logic is missing; the 
assumption being that it is rare that a task can slip more than 2 months without 
affecting the end date.  The threshold for this metric is that no more than 5% of the 
unfinished tasks in a schedule should have High Float. 

7. Negative Float – Negative Float occurs when the schedule predicts that a critical or 
contractual milestone will be missed, or a slipping task collides with a hard 
constraint.  Essentially, negative float suggest that the schedule will not achieve its 



  Improved Decision Making  

©2023 RTConfidence, Inc. V2.4  Page 76 

objectives and is usually a sign that intervention is necessary.  The threshold for 
negative float is zero.  Any task with negative float will fail this test. 

8. High Duration – This metric counts the number of unfinished tasks with duration 
greater than 44 workdays (2 months).  High duration tasks are problematic in many 
cases because it is challenging to monitor progress.  The remedy is often to further 
decompose the task into smaller, well defined tasks with shorter durations.  The 
threshold for this metric is that no more than 5% of the unfinished tasks in the 
schedule should have duration greater than 44 workdays. 

9. Invalid Dates – The metric for invalid dates examines both forecast and actual task 
start and finish dates.  Tasks forecasted to finish in the past (earlier than the project 
status date) or reported as having started in the future (later than the current status 
date) are deemed invalid.  The threshold for the Invalid Dates metric is that zero 
tasks in the schedule should reflect an invalid date because this undermines the 
credibility of the entire schedule. 

10. Resources – This optional metric represents the percentage of unfinished tasks that 
have resources associated with them.  Organizations that wish to use this metric 
can have it enforce that 100% of the unfinished tasks identify a resource.  

11. Missed Tasks – The missed task metric tracks the number of baselined tasks that 
were scheduled to finish on or before the status date but have not been marked 
complete.  This does not include tasks that are forecasted to be late after the status 
date, it is only retrospective.  The threshold for this metric is that no more than 5% 
of the tasks in the schedule should reflect missed dates. 

12. Critical Path Test – This is a pass/fail metric that evaluates the integrity of task 
logic in the schedule.  The first step is to identify the critical path in the task 
network, then the first task(s) in the network have a slip introduced and the 
resulting slip in the project end date should slip by the same amount.  If the slip 
inserted at the beginning is the same as the slip observed at the end, the test is 
passed, else the test is failed.  This test identifies bad task logic or hard constraints 
that are making the schedule unresponsive. 
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13. Critical Path Length Index (CPLI) – This is a measure of the efficiency required to 
achieve a schedule milestone at the assigned time, defined as the sum of the 
remaining project duration in workdays on the critical path plus total float (the 
difference between the forecast and baseline finish dates of the finish milestone), 
divided by the remaining project duration.  CPLI = 1.0 indicates that the project must 
execute exactly as planned to complete on time.  CPLI > 1.0 indicates that there is 
some schedule margin remaining.  CPLI < 1.0 suggests the project is not on track to 
achieve its goal.  The threshold for this metric is CPLI < 0.95 which indicates the 
project does not appear to be on track to achieve its schedule goals. 

14. Baseline Execution Index (BEI) – This metric evaluates the project team’s schedule 
performance against the baseline plan.  It is calculated by dividing the total number 
of tasks completed by the total number of baselined to have been completed by 
the project status date.  BEI = 1.0 indicates the project team appears to be executing 
according to plan.  BEI > 1.0 indicates that the project team is performing ahead of 
plan.  BEI < 1.0 suggests that the project team is behind schedule.  The passing 
threshold for this metric is BEI not less than 0.95.  

Although the DCMA assessment is not a widely recognized industry standard, it generally 
represents good scheduling practice.  Whether or not your organization is required to use 
it, you may find this analysis helps to identify issues with schedule logic and performance 
that should be investigated.  Satisfying these targets doesn’t mean that a schedule is 
credible or correct but failing to meet these goals indicates that a thorough schedule 
review to understand why the standards weren’t met might be in order. 

At any time, users can select the metrics button on the Chrono™ toolbar to display the 
results of the 14-Point assessment.  The metric information is stored in the Commitment 
Milestone’s “Note” section. 

 
Figure 78 The Metrics Button 

Note that the Chrono™ Validation Wizard has both some less stringent and more stringent 
requirements relative to the DCMA 14-point Metric, so an IMS can be considered “valid” by 
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Chrono™ standards, but may “Fail” the DCMA 14-point Metric standards.  An asterisk next 
to the score indicates a failed test, as shown below. 

 
Figure 79 Example of the DCMA 14-point Metric Scorecard Produced by Chrono™ 

A quick reference for the DCMA 14-Point Metric and the Chrono™ implementation can be 
found on the next page. 
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Figure 80 Comparison of Chrono™ Wizard and DCMA 14-Point Metrics 

 
  

DCMA 14-Point Metric Chrono™ Comparison*

1 Logic (inter-dependencies) Minimal missing Logic Links. +

# of tasks without predecessors and / or successors should not exceed 5%. 0 Exceptions per Chrono™ Wizard 

2 Leads (negative lag) Should not be used. +

Negative time is not demonstrable and should not be encouraged. 0 Exceptions per Chrono™ Wizard 

3 Lags Minimal usage allowed.

Should not be used to manipulate float/slack or to restrain the schedule.  Should 

not exceed 5%.

SS+ Allowed by Chrono™ Wizard

4 Relationship Types +

Finish-to-Start (FS) Encouraged (>90%) Chrono™ Default

Start-to-Finish (SF) Counter-intuitive: only rarely used, if Justified Not allowed by Chrono™

Start-to-Start (SS) OK Allowed by Chrono™ 

Finish-to-Finish (FF) OK Not allowed by Chrono™

5 Hard Constraints No more than 5% of tasks should have Hard Constraints. +

Hard: Must-Finish-On (MFO), Must-Start-On (MSO), Start 

No-Later-Than (SNLT) & Finish-No-Later-Than (FNLT)

Hard constraints prevent schedule from being logic-driven. Not allowed for Tasks in Chrono™

Can Accomplish in Chrono™ with Milestones

Soft: As-Soon-As-Possible (ASAP), Start-No-Earlier-Than 

(SNET), & Finish-No-Earlier-Than (FNET)

Soft constraints are OK. Chrono™ Default

6 High Float No more than 5% of tasks with Total Float/Slack in excess of 44 days (2 months). Computed by Chrono™ but not prevented 

(more specific to Earned Value Management)

May be a result of missing predecessors and/or successors. Not Specifically Imposed by Chrono™

(could easily add)

7 Negative Float Tasks should not have negative float. Milestones are Exempt

A task which has less than 0 Float/Slack does not support the Critical Path (CP). Not allowed by Chrono™

8 High Duration <5% of tasks with a Baseline duration >44 working days (2 months), within rolling 

wave planning window.

Computed by Chrono™ but not prevented 

(more specific to Earned Value Management)

Helps to break large tasks into 2 or more smaller tasks - makes schedule more 

manageable.

Not Specifically Imposed by Chrono™

(could easily add)

9 Invalid Dates Cannot forecast starts and/or finishes before the project Status date. 

Not logical or appropriate to back-date. 0 Exceptions per Chrono™ Wizard

10 Resources All tasks with durations greater than zero have dollars or hours assigned. Specific to Earned Value Management

If IMS is required to be resource-loaded. Not Specifically Imposed by Chrono™

(not Planned or needed for ES)

11 Missed Tasks No more than 5% of tasks should be late at a status update. +

% of tasks which were suppose to be completed by the baseline status date, but 

have forecasted finish dates after the status date. 

0 Exceptions per Chrono™ Wizard 

12 Critical Path Test Change in Critical Path task duration extension must result in same number of 

negative float/slack days for completion task/milestone.

+

This is a test for broken logic somewhere in the IMS network. 0 Exceptions per Chrono™ Wizard 

13 Critical Path Length Index (CPLI) CPLI < .95 is an indicator of inefficiencies to be investigated.

CPLI = (remaining duration of CP + TF)/(remaining duration of CP). Specifically Calculated by Chrono™

14 Baseline Execution Index (BEI) Metric measuring task throughput (>1 is good, and <1 is bad).

BEI cum = (total # of tasks complete) / (total # of tasks completed before status 

date + total # of tasks missing baseline finish date).

Specifically Calculated by Chrono™

Provides insight into the realism of program cost, resource and schedule 

estimates.

+ Chrono™ Exceeds this metric guideline Exclusions from above metrics:

    Completed Tasks

Chrono™ Meets this metric guideline     LOE (Level of Effort) Tasks

    Summary Tasks

Not Implemented but could (or do not have to due to ES vs EV Implementation)     Milestones

IMS Analysis Check-List Items
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The Chrono™ Toolbar 
Chrono™ functions will primarily be accessed by using the Chrono™ toolbar that exists in 
the Chrono™ tab installed in Microsoft Project®.  The tutorial will help you understand the 
commands in context.  This section is intended to serve as a reference to the toolbar and 
will go a little deeper than the tutorial in some cases. 

Organization 
The selections from the toolbar will be discussed from top to bottom, left to right.  The 
main headings are the labels under the different sections of the toolbar.  
 

Quick Tip Before We Begin 
If you hover your mouse over a button on the toolbar, a quick reminder of what the button 
does will be displayed. 

1.0 Chrono™ Tools 

1.1 Display Probability Chart = Pushing this button causes your browser to fetch and 
display the most recent Probability Chart previously generated for the project.  If 
the simulation has never been run for this project, pressing this button causes 
the simulation to be run.  You must have internet access to fetch the chart/run 
the simulation. 

1.2 Run TriCoBi™ Simulation = Pushing this button initiates validation of the 
schedule and execution of the simulation if the validation is successful.  When 
the simulation is complete, you will be asked if you wish to review the results.  
You must have internet access to run the simulation and display the results.  The 
results are displayed by your default browser.  Note: If you just got Chrono™ and 
are noodling around and the distribution chart just shows a single vertical bar, 
it’s likely you haven’t entered 3-point estimates for tasks so there is only a single 
point distribution to calculate and display. 

1.3 Chrono™ Wizard = Initiates the wizard to help you build a valid schedule and 
capture three-point estimates.  The wizard walks you through tasks collecting 
dependency and estimate information.  It also lets you capture risk and 
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opportunity information.  There is a separate section of this document that 
explains the wizard in more detail.  Many users discontinue use of the wizard 
once they are familiar with Chrono™, but the wizard will be invoked if and when 
structural errors in the schedule are recognized after trying to Validate Project 
(to help in troubleshooting).  The Chrono™ Wizard does not require an internet 
connection. 

1.4 Project Progress Update = Initiates a wizard to update project status compared 
to the current baseline.  This function is not useful until a Chrono™ baseline has 
been set.  The details of the wizard are described in a separate section of this 
document.  Note that setting a project baseline using Microsoft Project® menus 
(versus the process described below in 1.5) will not enable you to use this 
feature. 

1.5 Set Project Baselines = This button sets and records the Nominal (Critical Path) 
and Goal Confidence baselines for the current project in the Chrono™ cloud.  
Baselines cannot be set until the project has been validated, a simulation has 
been run to calculate the Goal Confidence Baseline, and the Microsoft Project® 
file has been saved locally.  Setting the baseline requires internet access and 
causes your project to be validated and the simulation to be run.  It also results 
in a backup of your project file being created locally. 

1.6 Validate Project = This button causes the project schedule to be validated 
against Chrono™ criteria that is aligned with the DCMA 14-point metrics.  If 
issues are detected that thwart validation, the Chrono™ wizard will be activated 
and direct your attention to the first task that caused the problem.  Validation is 
done locally and does not require an internet connection.  The DCMA 14-point 
metrics are detailed in a different section of this document. 

2.0 Chrono™ Gantt Chart Views 
The currently displayed view (Nominal Durations is the default) will have a green check 
mark next to it.  Pressing these buttons changes the attributes of the Gantt Chart 
displayed. 
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2.1 Nominal Durations = This button causes a display of the Gantt Chart that reflects 
Nominal (a.k.a. traditional Critical Path) task schedule.  This is the default Gantt 
Chart.  This button is helpful if you have been using other Gantt Chart Views and 
want to return to the basic Critical Path view that ignores simulation results. 

2.2 Goal Confidence @ 70% = Pressing this button causes one or both behaviors. 

1) If the project has never had a simulation run or if the schedule has been 
changed since the last simulation run (indicated by a red flag next to the 
button), it causes a validation and simulation to run and then…  

2) The Gantt Chart representing the Goal Confidence task durations will be 
shown on the Gantt Chart.  The pre-set Goal Confidence default is 70% and 
can be changed in the Defaults setting (see 5.1). 

2.3 High Risk Confidence @ 30% = Pressing this button causes one or both 
behaviors.  

1) If the project has never had a simulation run or if the schedule has been 
changed since the last simulation run (indicated by a red flag next to the 
button), it causes a validation and simulation run and then…  

2) The Gantt Chart representing the High-Risk Confidence task durations will be 
shown on the Gantt Chart. The pre-set High-Risk Confidence default is 30% 
and can be changed in the Defaults setting (see 5.1). 

2.4 Medium Risk Confidence @ 50% = Pressing this button causes one or both 
behaviors.  

1) If the project has never had a simulation run or if the schedule has been 
changed since the last simulation run (indicated by a red flag next to the 
button), it causes a validation and simulation run and then… 

2) The Gantt Chart representing the Medium Risk Confidence task durations will 
be shown on the Gantt Chart. The pre-set Medium Risk Confidence default is 
50% and can be changed in the Defaults setting (see 5.1). 
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2.5 Commit Confidence @ XX% = Pressing this button causes one or both 
behaviors.  

1) If the project has never had a simulation run or if the schedule has been 
changed since the last simulation run (indicated by a red flag next to the 
button), it causes a validation and simulation run and then…  

2) The Gantt Chart representing the Commit Confidence (based on the XX% 
value at the date selected for that manually scheduled end milestone) task 
durations will be shown on the Gantt Chart. 

2.6 Select Baseline - @XXXXXX = Allows the user to display either the Nominal 
(Critical Path) or Goal Confidence Baseline.  Select the baseline that you wish to 
have displayed.  The right side of this button indicates which baseline is 
currently being displayed. 

2.7 Align Commit = The first time the simulation is run, the Commitment Milestone 
should be set to the Critical Path end date represented by the Auto Scheduled 
Confidence Milestone/project finish.  The “Align Commit” button resets and fixes 
the Commitment Milestone to the end date consistent with the currently 
displayed Gantt chart schedule end date preceding the Commitment Milestone 
(I.e., Finish date of its Predecessor).  This is an alternative to manually adjusting 
the Commitment Milestone.  Note: If the Confidence Milestone calculation 
places it at the end of the business day (1700 hours being the default), the 
Commitment Milestone will be placed “right after” the Confidence Milestone 
which will be start of the next business day (0800 being the default).  “Align 
Commit” moves it to the end of the business day of the Confidence Milestone. 

2.8 View Entire Project = This button adjusts the scaling of the Gantt Chart being 
displayed so that it fits within the Gantt Chart area width (I.e., schedule span) 
currently displayed. 

3.0 Chrono™ Options 
3.1 Merge Bias View = This option toggles whether phantom tasks should be 

displayed that reflect the buffer calculated for merge bias effect.  If the green 
check mark is present, then the phantom tasks are displayed.  Merge bias is the 
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statistical delay projected for one or more tasks that merge into a common 
successor.  Merge bias is not displayed in the Nominal view and the button 
shows a strikethrough while in that view. 

3.2 Distribution-XXXXX = This is an indicator of which distribution is being used for 
the Chrono™ Simulation.  At this writing, there are two options Triangle (the 
default) or TriGen™.  Your distribution choice must be set before a project is 
baselined because changing after that would invalidate prior baselines.  For a 
detailed discussion of the differences, see this Appendix. 

3.2.1 Triangle calculates a probability distribution function using the Best-
Case Duration as the early bound, the Nominal Duration as the mode, 
and Worst-Case Duration as the upper bound. 

3.2.2 The TriGen™ option creates a slightly broader distribution function, 
establishing the Best-Case Duration as 10% likely, the Nominal 
Duration as the mode, and the Worst-Case duration as 90% likely.  
This allows a small chance that a task might finish before the Best-
Case or after the Worst-Case.  This option allows project managers to 
enable estimators to be more comfortable with providing reasonable 
estimates of Best- and Worst-Case durations without taking into 
account catastrophe’s (I.e., earthquakes, wars, building fires, ...). 

3.3 Metrics = This button displays the results of the DCMA 14-Point evaluation 
criteria (described in the prior section).   

4.0 Project Summary Info – Last Update [date of last update] 

4.1 Commit Date [Date/Time] = This displays the Commit Milestone date/time 
extracted from the most recent Goal Confidence Baseline.  This assumes that the 
Goal Confidence Commitment Milestone extracted from the last baseline is 
always the target end date of the project.  This value persists no matter which 
Gannt Chart View is currently being displayed. 

4.2 % Confidence at Commit Date XX% = This is the currently projected probability 
of achieving the Commit Date.  The Commit Date is defined as the Commitment 
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Milestone of the most recently saved Goal Confidence Schedule.  It will change 
as project updates and new baselines occur. 

4.3 Nominal Confidence XX% = This is the currently projected probability of 
achieving the Nominal (or Critical Path) Commitment Milestone. 

5.0 Chrono™ Settings, Ver. XXXXXX 

5.1 Defaults = This button allows you to modify the Chrono™ Default values.  These 
include the ability to have Chrono™ automatically calculate the Best-Case 
Durations and Worst-Case Durations as a percentage of the Nominal Duration.  
This also allows users to override some of the “Validate Project” task 
dependency rules.  This is where the user can choose the Triangle Probability 
Type.  These defaults must be set before the first simulation run. 

5.2 Contact and Help = This button provides links to additional resources on the 
RTConfidence web site for Help, general information, email support, feature 
requests, and issue reporting. 

5.3 Info = Details about Chrono™ include the current release and when this license is 
due to expire. 
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Chrono™ Settings & What They Mean: Establishing 
Defaults 
Chrono™ options fall into four categories: 

1) Selectively overriding some of the schedule validity checks for the DCMA 14-Point 
analysis or Chrono™ to match local practice. 

2) Adjusting the estimate and distribution curves used to run the Chrono™ simulation. 

3) Changing some of the labels (and their percentage settings) that Chrono™ uses for 
different confidence levels. 

4) Setting and changing the two Viewers authorized to view Chrono™ output charts. 

These options are set by users through the Default button in the Chrono™ tab, which 
displays the default settings dialog. 

 
Figure 81 The Chrono™ Default Setting Dialog Box 
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Overriding Validity Checks 
Prior to running a simulation, Chrono™ conducts a schedule validity check.  This can be 
initiated without running a simulation by pressing the Validate Project button in the 
toolbar.  Validation flags issues with the schedule that fail the Chrono™ IMS structure 
criteria (closely aligned to the DCMA 14-Point check) and poor scheduling practices that 
can cause unexpected or misleading schedule simulation results. 

We have a short description of the DCMA 14-Point metric check in this Appendix.  After 
you run a simulation, the Metrics button will display the DCMA stats from the evaluation 
of your schedule.  The only test that you can normally “fail” and have your simulation 
complete successfully is the “Resource” test, which Chrono™ treats as informational. 

Some of the DCMA tests must be passed or the simulation cannot run or cannot produce 
valid output.  Some of the DCMA tests represent good practices, but don’t prohibit the 
simulation. 

The Defaults button in the Chrono™ tab is where the validation override settings can be 
accessed.  Here you can allow the following schedule conditions/issues to be ignored: 

• Finish to Start + Lag 
While positive lag on a Finish to Start relationship is legal in MS Project™, it is 
discouraged, and flagged by Chrono™ as an error during validation.  DCMA allows 
no more than 5% of the incomplete tasks to have FS+Lag dependencies.  Chrono™ 
normally does not allow any.  The suggested approach would be to add a dummy 
task to represent and explain the rational for the lag, e.g., rather than “Paint the 
Chair” followed by a 1-day lag to allow the paint to dry before “Pack and Ship Chair”, 
insert a 1-day task titled “Paint on Chair Dries” with normal Finish to Start 
relationships.  Users may elect to have Chrono™ not flag lags as errors that cause 
validation to fail, although the Metrics display button will still show that the 
schedule failed to meet the Lag Check. 

• Finish to Start – Lag (Lead) 
Negative lag is weird.  Although allowed in MS Project™, it is usually considered a 
bad scheduling practice.  It is a way of saying “2 days before Task A finishes, task B 
should start”.   DCMA does not allow any negative lags because they can confound 
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calculation of Float and the Critical Path.  Usually, tasks can be decomposed further 
to eliminate the need for negative lag. If necessary, users may elect to have 
Chrono™ not flag negative lags as an error that block validation, although the 
Metrics display button will still show that the schedule failed to meet the “Lead” 
Check. 

• Start to Start – (Lead) 
Start to Start dependencies with a negative lag (or “lead”) is not considered good 
scheduling practice and normally would be flagged as an error by Chrono™ during 
validation that would cause validation to fail.  DCMA does not allow any negative 
lags because they can confound calculation of Float and the Critical Path.  Saying 
Task A has a SS-1w with Task B is saying that Task A should start 1 week before Task 
B starts.  Task A thereby requiring a crystal ball to know when to start.  There is 
usually a way to decompose the tasks to better represent what you are trying to 
capture that doesn’t jeopardize calculation of the critical path and schedule float.  
You can tell Chrono™ not to fail validation with this error in the Defaults.  The 
Metrics report will still show the failed DCMA test.   

Adjusting Estimate and Distribution Curves & Default Risk/Opportunity Causes  
The Chrono™ schedule simulation takes the project task network and task estimates as 
input to a simulated Monte Carlo process.  As users gain proficiency with Chrono™ they 
will likely gather 3-point estimates for tasks with significant schedule risk. To facilitate 
“quick and dirty” schedule assessment without requiring data entry of 3-point estimates, 
Chrono™ allows a shortcut: the definition of a “default” Best-Case and Worst-Case duration 
estimate calculated as a percentage of the Nominal estimate. 

Once Best-Case, Nominal (or “Likely Case”), and Worst-Case Duration estimates are 
assigned, Chrono™ offers users two different probability distribution options, Triangle and 
TriGen™.  Died-in-the-wool engineers sometime have issues with a 0% confidence Best-
Case duration estimate (for it cannot be met, by definition).  They sometime have issues 
with a 100% confident Worst-Case duration estimate (can people really be 100% 
confident?)  The creators of Chrono™ have found that the TriGen™ option enables that 
population of estimators to get past the 0% and 100% stigma. 
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Note: Defaults for these values must be set before the project is baselined.  Because 
changing these defaults after baselining would invalidate status reporting history and 
trends, the choices are locked for a given project once the project has been baselined. 

Finally, you can establish defaults for Risk and Opportunity causes that will be associated 
with the Best-Case and Worst-Case duration estimates.   

The Defaults button in the Chrono™ tab is where these settings can be accessed.  

Changing the Labels (and Percentages) Chrono™ Uses for Confidence Levels 
Chrono™ was initially developed by the authors for their own use.  They used terms familiar 
to themselves, “Nominal”, “High-Risk”, “Group”, “Business”, “Commit”.  When the tool was 
originally built, they intended to inflict these labels on all users. 

Project managers who later joined the Chrono™ team found some of these labels 
confusing or anti-intuitive in some cases and suggested that the tool be modified to allow 
user customizable labels.  The current defaults are shown below. 

 
Figure 82 Confidence Names and Levels Defaults 
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The prior figure shows the pop-up you see when you click on the “Confidence Names and 
Levels”.  You can change each label and the “% Confidence” levels of the 3 used to 
represent organizational governance guidelines.  The Red, Yellow and Green zones that 
you see on the Distribution Trend charts tab in the simulation output are based on how the 
High Risk and Medium Risk % Confidences are set (i.e. High Risk which separates Green 
from Yellow, and Medium Risk which separates Yellow from Red).   

The Goal % Confidence can be set at whatever the acceptable Commitment % Confidence 
is.  This setting establishes the ES (Earned Schedule) commitment confidence Baseline – 
thus, before baselining an IMS, the Goal and Commitment % Confidence values should be 
set equal for generation of valid ES metrics.  They should be set to whatever the 
desired/approved Commitment Confidence date and % are along the S Curve.    

Managing Chrono™ Access via User and Viewer e-mail Addresses 

Chrono™ safeguards your output data by only enabling select individuals to view the 
outputs.  This safeguards against unauthorized or unwanted access to your valuable output 
data.  By selecting the top-right Login button, you open a pop-up screen (as shown in the 
next figure) to manage access.  Note that Usernames must be valid e-mail addresses.  The 
Chrono™ Username is prepopulated via the licensing process.  Viewers are input by 
Chrono™ license holders, and can be assigned to anyone, even individuals without 
Chrono™ or Microsoft Project licenses.  The Viewers will have to establish a unique 
password when they log-in for the first time (again, this process is in place to protect user 
data).  
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Figure 83 Chrono™ Login Pop-up Screen 

 

Again, your e-mail address (attached to your license) and password are required for you to 
access the simulation output data.  This e-mail address is used as the account’s username.  
Password access is granted for a 24 hour window, beyond which re-entering the password 
is required. 

With the basic Chrono™ license you receive two ChronoView™ licenses that enable others 
to view your valuable simulation output data in a secured way.  To do this you simply 
provide their e-mail addresses.  You are then able to allow these select individuals to open 
your output URL (see next figure for location of URL).  Select, Copy and Paste this URL in an 
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email to them, and once they register, they will be able to login and view the same data 
that you see. 
   

 
Figure 84 Chrono™ Charts URL Location 

 
Chrono™ Used/Reserved Data Fields 
Chrono™ keeps project information in two places: 

1) Tucked into corners of your local MS Project file. 
2) History and trend information is stored in the cloud when you run a simulation. 

This appendix describes the columns that Chrono™ uses in your MS Project file.  These 
columns are normally available to users, but rarely used.  If you use Chrono™, we reserve 
them, and they are not available for your use and should not be modified. 

Before importing an existing file into Chrono™, you should assure that the file is not using 
these fields (they are normally blank).  If you are building a new project file using Chrono™, 
Chrono™ will prohibit you from using these fields (if you find a way around the prohibitions 
and use or change the fields, the results will be unpredictable). 
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MS Project has two types of information that it stores about your project: 
• Task Level information  
• Project Level information  

The following Task fields are reserved for Chrono™ use: 
Baseline Duration 
Baseline9 Duration 

Baseline10 Duration 
Duration1 
Duration2 
Duration3 

Duration4 
Duration5 
Duration6 

Duration7 

Flag12 
Flag13 
Flag15 
Number11 

Number12 
Text10 

Text11 
Text13 

Text14 
Text15 
Text16 
Text17 

Notes2 

 
2 The Notes column of the Commitment Milestone contains a copy of Metrics output data and the Notes column of the 
Start Milestone contains the URL for the Schedule Distribution report to facilitate sharing.  “Notes” for other tasks are not 
used by Chrono™. 
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The following Project Summary fields are reserved for Chrono™ use: 

Flag5 
Flag6 
Flag7 
Flag8 
Flag9 
Flag10 
Flag11 
Number3 
Number4 
Number5 
Number6 
Number7 
Number8 
Number9 
Number10 
Number11 
Number12 
Number13 
Number14 
Number15 
Text3 

Text4 
Text5 
Text6 
Text7 
Text8 
Text9 
Text10 
Text11 
Text12 
Text13 
Text14 
Text15 
Text16 
Text17 
Text18 
Text19 
Text20 
Text21 
Text25 
Text26 
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Chrono™ Limitations 

Microsoft Project® (MSP) is a complex and sophisticated project management tool.  
Chrono™ is a sophisticated schedule risk management tool that interacts with MSP to 
support better user scheduling and decision making.  Because Chrono™ lives on top of MSP 
rather than inside, there are several constraints that Chrono™ users must be aware of to 
use Chrono™ effectively. 

Chrono™ assumes that users are running a current and “vanilla” (unmodified) version of 
MSP, otherwise results are unpredictable.  We suggest users familiarize themselves with 
this list of assumptions and limitations.  If you encounter issues using Chrono™ check this 
list first for clues about how they might be resolved. 

1) An internet connection is needed to run a schedule simulation - Although you can 
enter data in MSP with Chrono™ installed and validate the schedule, you cannot set 
a baseline or run a simulation without an internet connection. 

2) Chrono™ is the only macro that can be installed and used in your MSP 
implementation.  A portion of Chrono™ is implemented as an MSP macro that is 
installed when you install the tool.  Some macros don’t play well with others.  As a 
consequence, having other macros installed in your MSP implementation is not 
supported and may lead to unpredictable results. 

3) Global.mpt is replaced when Chrono™ is installed - To preserve any data in your 
existing Global.mpt file, when Chrono™ is installed or updated, the current 
Global.mpt file is renamed and a new one is created that includes the latest 
Chrono™ components. 

4) Chrono™ supports only one calendar - Microsoft Project® can support multiple 
calendars that specify workdays and work times being associated with different 
tasks within a schedule.  These include a global calendar, individual resource 
calendars, even task level calendars and exceptions.  If an MSP schedule refers to 
multiple calendars, results are unpredictable.  The principal reason for this limitation 
is that the SRA (Schedule Risk Analysis) probability charts and ES (Earned Schedule) 
calculations need all the tasks to use the same workdays and times to produce valid 
results. 
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5) Store your calendar in the MSP file - If you have only one calendar associated with 
your project, it can be stored in three places: 

a. In the Global.mpt file (Global Calendar) – This will affect all schedules, but 
will be in danger of being archived when Chrono™ updates are installed – 
NOT RECOMMENDED 

b. In a local template file (*.mpt) from which an MSP file may be created – this 
copies the template calendar into the MSP file at creation where it can be 
further modified as needed.  Allows creation of standard holidays and work 
hours one time in the template without the danger of Chrono™ archiving the 
template (as the Global.mpt can be). 

c. In the MSP file itself – This calendar will only apply to the project being 
edited. 

6) Avoid using Chrono™ reserved columns/fields – MSP has many optional columns 
that exist but are reserved for the user.  Chrono™ uses several of these (see detailed 
list here) to store estimation and baseline data.  Users may also use “Enterprise 
Fields”. 

7) Importing existing files can be a problem – Chrono™ supports import of existing 
MSP files from the 2013, 2017 and 2019 versions, assuming that they don’t violate 
other constraints on this list and are “well formed”.  Files that have existing 
baselines or tasks that are partially complete can cause issues.  The safest way to 
import existing files is to open them and copy and paste task and dependency 
information into a fresh MSP file. 

8) Chrono™ doesn’t currently facilitate managing resources and costs – Resource and 
cost information shown in MSP will be based on the nominal schedule only.  

9) Chrono™ currently supports schedules with < 1000 tasks with variable durations – 
The data file that Chrono™ exchanges with the cloud is large and we are working to 
overcome a data timeout that occurs when attempting to send larger files. 

10) Chrono™ doesn’t currently support actively using Summaries – Summaries that are 
made “active” (i.e., given predecessors and/or successors, and/or explicit durations) 
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may cause issues which cannot be remedied by Chrono™ and might not be 
salvageable for use with Chrono™. 

11) Chrono™ cannot work with versions of MS Windows™ earlier than Version 10. 
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Chrono™ Validations/Well Formed Schedules 

Whether a schedule with 3-point estimates is simulated with the Monte Carlo or TriCoBi™ 
algorithms, the structure of the schedule must be “well formed” or the simulation will 
either fail or worse, the results would not be representative of the project risks and the 
expected outcome. The Chrono™ Validate Project wizard was designed to help users 
confirm that their schedules are well-formed and are likely to provide accurate simulation 
results.  

The Validate Project wizard is available to launch on the current schedule using the button 
on the Chrono ribbon. It will also launch automatically when changes the schedule require 
a restimulation to present accurate simulation results. 

The validation process driven by the wizard goes through the following steps: 

1) Validation places the schedule in Nominal. 
2) Validates the starting and ending milestones. 
3) Configures merge tasks. 
4) Runs an auto-validation or at least a manual task check. 
5) Checks each tasks’ duration. 
6) Checks each tasks' predecessors and successors.  
7) If the project validates, then the durations are then backed up. 
8) Starting and ending milestones are added if necessary.  
9) Merge bias tasks are inserted if in Merge Bias View.  

Newly opened files will automatically run the Validate Project wizard. The Metrics button 
in the Chrono™ ribbon will also automatically run the Validate Project wizard as part of the 
metrics collection process and will provide a warning of any schedule issues found.  

The Project Validation wizard checks the following items and warns for any issues, noting 
the number of failures and first task failure: 

• Project File Options Schedule does not match Project Calendar 
• First task before project start  
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• Summary Tasks with predecessors and successors 

For incomplete tasks: 

• Manual duration tasks (only manual milestones allowed) 

• Task starts before predecessors end 

• Task constraints other than as soon as possible 

• Task calendar differs from project calendar 

• Task, other than start and manual milestones, lacks predecessors 

• Task links with FF (Finish to Finish) or SF (Start to Finish), which are not allowed 

• Task links FS (Finish to Start)+, FS (Finish to Start)-, or SS (Start to Start), which are 
not allowed unless enabled under Defaults 

• Task links SS (Start to Start)+ with lag time greater than task duration 

• Task, other than end and manual milestones, lacks successors 

• Task successors start before task will complete 

• Task incomplete but successors started or complete 

• Task with only SS successors 

• Task complete but started before predecessors complete 

• More than 50 predecessors or successors 

Other validation rules: 

• Only manual milestones are allowed.  

• Manual task check will warn of manual duration tasks before making them all auto-
scheduled.  

• Manual duration validation checks for each task that has Best <= Nominal <= Worst 
with 0 denoting default equality.  

Manual predecessor and successor checks for each task: 

• do not exist for summaries 
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• do exist and are valid for duration tasks i.e. not absent, blank, or a summary 

• are within the main schedule and not isolated by itself 

• have appropriate links (i.e. not FF or SF, not FS+, FS-, or SS-) unless enabled under 
Defaults 

• not SS+ with lag time greater than task duration 

• not SS only successors, and successors of an incomplete task are not started or 
complete. 
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Triangle vs. TriGen™ - What’s the Difference? 

In Chrono™ the duration of tasks is represented by continuous probability distributions. 
Two types of probability distributions are made available for task duration estimates — the 
standard triangle distribution and the proprietary TriGen™ distribution.  All tasks in the 
project that are characterized with “3-point” distributions will use the same distribution 
type as set in the defaults dialog.  

TRIANGLE DISTRIBUTIONS 

The triangle distribution used in Chrono™ is the standard triangle probability distribution 
that has a probability density function shaped like a triangle as defined in numerous 
statistics textbooks with readily available explanations on various web sites. The triangle 
distribution is applied to project tasks with best case duration being the minimum value, 
the likely/nominal case duration being the peak value, and the worst case duration being 
the maximum value of the triangle. In project science, we call these three durations the 
three points of the 3-point estimate.  

In the figure below, the best case duration is 10, the likely/nominal duration is the “mode” 
of the triangle (or in this case 20 days), and the worst case duration is 40 days. The 
frequency axis shows the probability density function value of the task duration along the 
continuous range from the best case duration to the worst case duration.  
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Figure 85 Sample Triangular Distribution Function and “S” Curve 

 

Just as the triangle in a 3-point estimate is represented by the probability density function, 
the cumulation of the frequencies across the duration range of the triangle is represented 
by the cumulative distribution function, which we refer to as the “S” curve. The value units 
of the S-curve are in percent confidence representing the probability of a task being 
completed on or before the corresponding time duration value. 

Therefore, at any point in time along the project schedule, the probability of a task being 
completed on or before a specific date is shown in the “S” curve. In the case above, the 
probability of the task being completed with a duration of 10 or less is zero. The probability 
of a task being completed at a duration of 40 is 100%. It is often misunderstood that the 
peak value represents a 50% probability, but that is not true.  

If you think about it, you may understand that many more things can go wrong on a 
project than go right. Consequently, it is natural to understand that as triangle distributions 
are applied to project science that the probability of completing the likely/nominal case 
task within a specific duration is typically well under 50%. In the case of our example 
above the likely/nominal case has a probability of about 33% -- this is basically calculated 
as [(Nominal Duration – Best Case Duration)/(Worst Case Duration – Best Case Duration)] 
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or 10/30 = 0.3333 = ~33%. This common misunderstanding is the root of many scheduling 
problems, but with the right tools, the actual probabilities are straight forward to calculate. 

TRIGEN™ DISTRIBUTIONS 

During a series of applications 3-point estimates to business-critical project schedules, we 
found that some engineering and development teams had a very difficult time determining 
the actual best case where the probability hits zero and the worst case where the 
probability hits 100%. There tended to be a mention of miracles, earthquakes, and fires 
when we talked about extremes of 0% and 100% likelihood completion of tasks. While we 
did have a fire in a lab once, that broke the schedule and required a re-baselining activity.  

Solving the general problem of helping the technical team become comfortable with 
giving a best case estimate, we simply ask the team to give a duration estimate that has a 
10% likelihood of occurring. Correspondingly we asked the team to provide a duration with 
a 90% likelihood to be the worst case estimate. The team felt that these 3-point estimates 
represented their reality, and we were happy that they did not include any miracles, fires, 
or earthquakes.  

The TriGen™ distribution is represented in Chrono™ with a triangle distribution that is 
created by reducing the duration of the 10% estimate (best case) provided by the team to 
a zero probability using the slope of the line between likely/nominal duration and the 10% 
duration. Correspondingly, the 90% duration (worst case) is extended using the slope of 
the line between the likely/nominal point and the 90% duration point to give duration 
with a 100% probability. 
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Figure 86 Sample Triangle Made from TriGen™ Inputs 

The example above shows that a best case of 15 and a worst case of about 32 with the 
same likely/nominal duration of 20 provide an equivalent probability distribution as a 
triangle distribution of best case 10, likely 20, and worst case 40. 

Whether to use the triangle distribution or TriGen™ distribution is up to the project team. 
We recommend that the team uses which ever distribution that most closely matches their 
project’s characteristics  
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Optimizing a Schedule for Merge Bias 
There is another scheduling phenomenon referred to as “merge bias,” which might not be 
noticed on a Gantt chart, but its affects can be surprising when the project schedule 
simulation results are inspected.  Basically, it has to do with having more than one closely 
time-matched network of tasks merging into the same subsequent task.  

For example, if you have three critical paths at a particular point in your schedule and each 
critical path has the same end-date probability distribution with a 50% probability of 
meeting schedule, the resulting probability of meeting schedule drops to 12.5% 
(0.5*0.5*0.5).   

Multiple “near-critical” paths have the same basic effect, as shown in the figure below, 
which depicts project simulation results for one task and then a simulation of two 
additional tasks close to the critical path. Comparing these distributions and their 
corresponding S-curves, we can see the probability drop from 50% to 20% due the near 
proximity of the three task end-dates. 

 
Figure 87 Simulation Results for Example “Merge Bias” Scenarios 
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The probability function of the single task shows the standard triangle distribution. The 
probability function of the three tasks combined in probability function derived from the 
simulation show a bell curve.   

The S-curve of the single task shows the likely/nominal confidence level of 50% for a 1/22 
end date. The S-curve of three near critical path tasks shows a confidence level of 20% for 
the 1/22 date. This example plays out all the time in project scheduling much to the surprise 
of the project teams. Being aware of this effect in the planning and executing processes 
can literally save your project from an impending disaster. 

Chrono™ the TriCoBi™ simulation highlights this problem with its merge bias chart. The 
process for optimizing for merge bias includes the project team finding ways to reduce 
near critical path tasks and then running what-if scenarios to mitigate the schedule risk. 
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Chrono Schedule Duplication Options (Save As 
Function) 

The “Save As” dialog provides the ability to duplicate the project for various purposes. 
Chrono™ projects have two components. The first component is a local Microsoft Project® 
file stored on the user’s personal computer. The second component is a secure database 
entry in the Chrono™ cloud service. The cloud database entry is tied with a reference link 
directly to the corresponding local Project file. If the Project file is copied over to a second 
computer, when the file is opened on the second computer and the TriCoBi™ simulation is 
run, the original database record in the Chrono™ cloud service will be accessed, and any 
project updates provided will be saved in the cloud as if the updates were made from the 
original file and the original personal computer.  

Caution must be taken to prevent multiple simultaneous project updates from occurring 
the same time from different computers. This unsynchronized practice would result in the 
Chono™ cloud service being out of synchronization with both local Project data files to the 
two separate personal computers. The one-to-one relationship between the Chrono™ 
cloud database entry and the local Project data file must be always preserved to ensure 
proper data synchronization. 

The “Save As” function duplicates the original Project file and creates a new storage 
location in the cloud to correspond with the new local Project file. The original Project file 
and the corresponding original project history are not modified by the “Save As” function. 
Also the “Save As” function clears the baseline data in the new Project file.  

The “Save As” function is typically use for either creating project templates for new 
projects or for re-baseline on-going projects.   

CREATING NEW PROJECT SCHEDULE TEMPLATE 

The steps to create a template for a new project are as follows: 
1) Select “File > Save” to save the Project file to confirm that the original file is 

preserved. 
2) Select “Save As” to save the Project file to a different name for the template.   
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3) Select the “Clear” option in the “Save As” dialog to clear out all “percent complete” 
task updates. 

 
Figure 88 Save_As Help Screen Options 

CREATING A RE-BASELINED PROJECT SCHEDULE  

The steps to create a re-baselined Project file are listed here and in the tutorial sections 
above: 

1) Select “File > Save” to save the project file to confirm that the original file is 
preserved. 

2) Select “Save As” and save the project file to a different name to hold the re-
baselined project schedule.  

3) Select the “Retain” option in the “Save As” dialog for the purposes of creating a re-
baselined project schedule. 

4) Following steps in the tutorial section for details on how to finish setup the re-
baselined schedule in the new Project file.  
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Chrono™ Project Wizards 
One of the largest barriers in the past to using Monte Carlo simulations for project 
estimation was the complexity of creating well-formed schedules. Typically, project 
experts with either experience or specialized training with Monte Carlo simulations were 
required to get reliable results. If mistakes are created while preparing the pre-simulation 
project data, then the output of the simulation cannot be trusted to guide project 
decisions. The set of Chrono™ project wizards greatly help mitigate this problem by 
walking the user through a path that will commonly result in a well-formed schedule. As 
always, the project manager will need to confirm that the results are reasonable and, with 
experience, notice any anomalies that the set of Chrono™ wizards might not catch. The set 
of Chrono project wizards are listed in the table below. 

Chrono Project Wizards 
Wizard Name Wizard Functions Activation Method 
  

1 Blank Project 
Wizard 

Sets up a New Project with essential start 
and end bounds. Pre-establishes Project 
Settings which enable a Valid Project set-up. 

User Selection via "New" 
File Options. 

2 Chrono 
Wizard 

For setting up new projects: Sets Hard and 
Soft Constraints conducive to SRA (Schedule 
Risk Analysis) and EVM (Earned Value 
Management). Incrementally helps Users set 
up and change Predecessor/Successor Task 
Relationships. Enables establishment of valid 
Task Interdependencies. Incrementally helps 
Users establish and change 3-point duration 
estimates per Task. Provides drop-down 
menus for Task Opportunity and Risk 
Descriptions. For fixing validation issues is 
launched automatically and incrementally 
goes to tasks with issues (e.g., 
Predecessor/Successor Task Relationships, 
Task Durations and 3-point estimates).  This 
Wizard is driven by Default settings.  

Activated by the Chrono 
Tab Button. This wizard is 
automatically triggered 
when the Validation 
Wizard finds an Issue to 
resolve. 
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Chrono Project Wizards 
Wizard Name Wizard Functions Activation Method 
  

3 Validation 
Wizard 

Checks the entire Project structure to ensure 
that construction criteria for appropriate 
SRA (Schedule Risk Analysis) and EVM 
(Earned Value Management) is supported. 
Provides help and options for fixing issues 
identified by automatically launching the 
Chrono Wizard to help fix IMS issues. 

Activated by the Chrono 
Tab Button. This wizard is 
automatically triggered 
when identifies need for 
Simulation updates (due 
to changes) and Chrono 
Tab Button. 

4 
TriCoBi™ 
Simulation 
Wizard 

Collect and sends all the IMS data to the 
Cloud for SRA and Earned Schedule 
computations and graphic output 
generation. Automatically invokes the 
Validation Wizard if changes have been 
made. 
 
 
Formats the Simulation Data for multiple 
Gantt chart views in local MS Project file 
which are accessed by Chrono tab buttons. 

Activated by the Chrono 
Tab Button or whenever a 
RED Flag in the Chrono 
Tab is selected. 
 
This wizard is 
automatically triggered 
when Baselines are 
established, and when 
Project Progress Updates 
are Previewed and 
Published. 

5 Gantt Chart 
View Wizard 

Creates the database for multiple (i.e., 4 or 5) 
IMS Gantt charts (at different 'S' Curve 
%Confidence values) and sends to local MS 
Project file. Enables the different Gantt 
charts to be displayed in the local MS Project 
file when the Chrono Tab selection is made. 

This wizard is 
automatically triggered 
when viewing the selected 
IMS Gantt charts and their 
column data. Enables 
viewing with either 
Baseline for comparison 
purposes. 
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Chrono Project Wizards 
Wizard Name Wizard Functions Activation Method 
  

6 
Set Project 
Baseline 
Wizard 

Automatically established IMS (Integrated 
Master Schedule) Baselines (both a 
"Nominal" task duration baseline for the 
traditional Critical Path and a Business task 
duration baseline established for the Team 
Commitment). Sets up the ES (Earned 
Schedule) Baseline data for use in generating 
ES metrics automatically. Provides a warning 
to user to ensure Sponsor approval is 
obtained first. Enables Selection of either 
Baseline in the Gantt Chart Views - the 
default for Nominal and Business Gantts are 
the Nominal and Business Baselines. 
Automatically disables "Defaults" from being 
changed after the Baseline is set - this 
prevents inappropriate changes. 

Chrono Tab Buttons -- one 
for setting the baselines, 
and the other for selecting 
the baseline in Gantt 
Views. 

7 

Project 
Progress 
Update 
Wizard 

Walks the user through Project progress 
updating that enables automatic generation 
of new SRA and Earned Schedule outputs. 
User sets the Update date, are sequenced 
through updates of Tasks that were open 
during that time up to the update date, 
automatically changes 3-points for 
remaining durations, allows checking of 
data, previewing of update results, and 
officially publishing the update when ready 
to do so. Ensures that the correct process is 
followed to make updating easy. 

Chrono Tab Buttons, which 
are only available after the 
project plan has been 
"Baselined." 
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Chrono Project Wizards 
Wizard Name Wizard Functions Activation Method 
  

8 Metrics 
Wizard 

Evaluates IMS relative to the DoD’s DCMA 
14-point Metrics, established in 2005 to 
ensure that IMS designs can support Earned 
Value Management calculations.  This set of 
criteria is also valid for SRA Modeling and 
Simulation and Earned Schedule calculations.  

Activated by the Chrono 
Tab Button.  

9 SRA Output 
Wizard 

A cloud-based system that takes current 
inputs and converts those into Graphic 
Outputs for SRA, ES and other data as 
deemed necessary (i.e., SRA Tornado chart, 
Merge Bias charts, Trend charts, etc.). 
Includes controls for knowing when 
Baselines are established, and Updates are 
processed – and provides trend data by 
keeping track of past inputs. The 
Distribution chart enables the user to go to 
any project Task within the network and 
view the: Input Distribution, Task 
Distribution, and Output Distribution – 
whereby the Output Distribution is the 
combination of Input and Task Distributions. 

This wizard is 
automatically triggered 
when the TriCoBi™ 
Simulation is run, and user 
chooses to view the 
Probability data. 

10 

Earned 
Schedule 
Output 
Wizard 

Takes Baseline and Update input data and 
establishes a data set that is used to process 
integrated trend charts with Earned 
Schedule performance indices and 
independent schedule estimations. Passes 
the data to the SRA Output Wizard. 

This wizard is 
automatically triggered as 
a result of selecting the 
“Set Project Baselines” and 
when Publishing “Project 
Progress Updates.” 

11 
Merge Bias 
Wizard 

This Wizard both quantifies the Merge Bias 
(i.e., extra schedule impact contributed to 
the SRA output as a result of the merging of 
overlapping parallel Tasks within the IMS 
network) and enables an innovative Gantt 
chart view that displays it graphically. 

Chart is automatically 
triggered when the TriCoBi 
simulation is run. Gantt 
chart view is activated by 
the Chrono Tab Button. 
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